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Notices

Trademarks
AJA® and Because it matters.® are registered trademarks of AJA Video Systems, Inc. 
for use with most AJA products. AJA™ is a trademark of AJA Video Systems, Inc. for 
use with recorder, router, software and camera products. Because it matters.™ is a 
trademark of AJA Video Systems, Inc. for use with camera products.

Corvid Ultra®, lo®, Ki Pro®, KONA®, KUMO®, ROI® and T-Tap® are registered trademarks of 
AJA Video Systems, Inc. 

AJA Control Room™, KiStor™, Science of the Beautiful™, TruScale™, V2Analog™ and 
V2Digital™ are trademarks of AJA Video Systems, Inc.

All other trademarks are the property of their respective owners.

Copyright
Copyright © 2023 AJA Video Systems, Inc. All rights reserved. All information in 
this manual is subject to change without notice. No part of the document may be 
reproduced or transmitted in any form, or by any means, electronic or mechanical, 
including photocopying or recording, without the express written permission of AJA 
Video Systems, Inc.

Contacting AJA Technical Support or Sales
Please have all pertinent information at hand prior to contacting AJA support or sales.

	 Support Telephone:	 +1.530.271.3190

	 Support Website:	 https://www.aja.com/support/contact

	 Support Email:	 support@aja.com

	 Sales Email:	 sales@aja.com

	 Shipping Address:	 AJA Video Systems 
		  180 Litton Drive 
		  Grass Valley, CA 95945, USA

https://www.aja.com/support/contact
mailto:support%40aja.com?subject=
mailto:sales%40aja.com?subject=
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Chapter 1 – Introduction

Overview
HDR Image Analyzer 12G delivers a comprehensive array of tools for the 
effective analysis of up to 4x 4K/UltraHD signals, utilizing both 12G-SDI and NDI 
connectivity.

Analyze HLG, PQ, Rec.2020, Rec.709, and native camera Log color spaces – from 
8K/UltraHD2/4K/UltraHD/2K/HD content in a powerful, real time, 1RU device. 

Developed in partnership with Colorfront, the AJA HDR Image Analyzer 12G 
supports a wealth of inputs from camera Log formats to SDR (Rec. 709), PQ (ST 
2084), and HLG and offers Wide Color Gamut (WCG) support for BT.2020 alongside 
traditional BT.709 and P3, with Dolby Vision® dynamic metadata inspection and 
analysis for advanced HDR mastering and QC applications. AJA hardware prowess 
ensures high reliability and performance, with 4x 12G-SDI inputs, dual 10 GigE, 
and DisplayPort connections.

Specifically designed to be used wherever high performance color analysis 
is needed, the 1RU form factor excels in a range of environments, providing 
the confidence you need for consistent and predictable HDR production and 
mastering.

Software Features 
•	 HDR Waveform, Histogram, and Vectorscope Monitoring
•	 Multi-channel signal analysis of up to 4x 4K/UltraHD HDR/WCG simultaneously 

via 4x 12G-SDI inputs
•	 Single channel signal analysis of 8K/UltraHD2 HDR/WCG
•	 Mix and match SDI and NDI signal monitoring and analysis
•	 UltraHD UI for high resolution picture display including PQ support for HDR 

capable displays via integrated DisplayPort
•	 Configurable layouts allow you to put the tool you need in the window you 

need it 
•	 Support for display referred SDR (Rec.709), HDR ST 2084/PQ, and HLG analysis
•	 Support for scene referred ARRI, Canon, Panasonic, RED and Sony camera 

color spaces 
•	 Dolby Vision dynamic metadata inspection and presentation
•	 Precision CIE graph, vectorscope, waveform, and histogram support
•	 False color mode to easily spot out of gamut/out of brightness pixels 
•	 NIT levels and audio phase metering
•	 Line mode to focus a region of interest onto a single horizontal or vertical line
•	 File base error logging with timecode
•	 ARRI LogC4 WideGamut4 LUT support
•	 Scope LUT applies a 3D LUT to signal being analyzed
•	 Display LUT applies a 3D LUT to only the monitoring display
•	 Three year warranty
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Hardware Features
•	 One RU height rack mountable chassis
•	 Hot swappable redundant power supplies
•	 HD-BNC twist-lock SDI connectors, HD-BNC to BNC adapters included
•	 Three DisplayPort outputs plus one DisplayPort over USB-C output
•	 Two Network Interface Cards
•	 Four USB connectors, two USB 3.0 and two USB 2.0

HDR Image Analyzer 12G Hardware
AJA's HDR Image Analyzer 12G is a 1RU hardware appliance equipped with AJA 
input and output. The system is designed for immediate use, automatically 
powering up to the Colorfront Analyzer application.

Chassis Front
Figure 1.  HDR Image Analyzer 12G Chassis Front View

 
Cooling Air�ow Entrance Power Switch

Chassis Power Button
The main power switch is used to apply or remove power from the power supply 
to the system. Turning off system power with this button removes the main 
power but keeps standby power supplied to the system. Therefore, you must 
unplug all system power cords before servicing. 

Chassis Rear
Figure 2.  HDR Image Analyzer 12G Chassis Rear View 
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Rear Panel Power Supply LEDs
On the rear of each power supply module an LED indicates its status as follows.

•	 Solid Green: When illuminated, indicates that the power supply is on.
•	 Solid Amber: When illuminated, indicates the power supply is plugged in and 

turned off, or the system is off but in an abnormal state.
•	 Blinking Amber: When blinking, this system power supply temperature has 

reached 63°C. The system will automatically power-down when the power 
supply temperature reaches 70°C and restarts when the power supply 
temperature goes below 60°C.
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Chapter 2 – System Installation

Installation Summary
1.	 Unpack the shipping box, removing the HDR Image Analyzer 12G, two 

power cords, and five HD-BNC adapter cables.

2.	 Mount the physical chassis as desired, using the provided sliding rails. 
Cooling airflow enters the chassis from the front, and exits from the rear and 
top panels. Do not obstruct these air vents.

3.	 Connect the two HDR Image Analyzer 12G power cords to AC mains. For 
redundancy, use both power supplies and connect them to separate branch 
circuits so that the HDR Image Analyzer 12G will continue to operate even if 
a circuit breaker opens on one branch.

4.	 Connect a computer monitor (user supplied) to one of the rear DisplayPort 
ports.

5.	 Connect a keyboard and mouse (user supplied) to available rear USB 
connectors.

6.	 Connect the BNC adapter cables to the HDR Image Analyzer 12G 
connectors.

7.	 Connect the HDR Image Analyzer 12G inputs to your video source, and 
outputs to your mastering display monitor, if used.

8.	 Power up the chassis. The system will boot up to the Analyzer application.

Hardware Installation

Shipping Box Contents
An HDR Image Analyzer 12G is shipped with two AC power cords and BNC 
adapter cables. Rackmount brackets are provided as part of the chassis.

As you unpack the shipping box, carefully examine the contents. Make sure you 
received everything and that nothing was damaged during shipment. If you find 
any damage, immediately notify the shipping service and supply them with a 
description of the damage. AJA will repair or replace damaged items.

If you find shipping damage, contact your AJA dealer or distributor for details on 
how to have your HDR Image Analyzer 12G repaired or replaced.

NOTE:	 Save packing materials and the shipping box. If your HDR Image Analyzer 12G 
ever requires service or you move your system, use the packaging materials and 
box for safe shipment.

Rack Mounting the Chassis
Install the HDR Image Analyzer 12G chassis into a standard 19-inch wide 
equipment rack, allowing space for cooling airflow. The chassis occupies only one 
vertical rack unit.

Two rack rail assemblies are included in the rack mounting kit. Each assembly 
consists of two sections: an inner fixed chassis rail that secures directly to the 
server chassis and an outer fixed rack rail that secures directly to the rack itself.
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The rail assemblies are shipped with rack adapters installed for use with IT (square 
hole) style rack frames. For IT racks, simply slide the unit into place, as the rails will 
lock automatically. For use with a standard round hole rack frame, you will need 
to remove the adapters using a small Phillips head screwdriver. 

Network Configuration
The HDR Image Analyzer 12G ships configured for DHCP operation. If your facility 
uses DHCP, simply connect one of the active Ethernet RJ-45 connectors to your 
network.

To manually configure your HDR Image Analyzer 12G's IP addresses, on the 
Analyzer application press the Tab key on the keyboard when no dropdown 
menu is visible to open the Settings screen, and select NETWORK.

See "NETWORK Tab" on page 41 for more information.

Initial System Startup
On initial system startup, no login is required, but you will need to accept 
End User License Agreements (EULA) for Microsoft and NVidia. The EULAs are 
displayed on the first startup and after every update.

Software Update
AJA's HDR Image Analyzer 12G ships with Analyzer software preinstalled with the 
latest version. 

Updates to the software are available at:

https://www.aja.com/products/hdr-image-analyzer-12g#support

IMPORTANT:   When upgrading from an earlier version of firmware (before v3.0), all Setups 
should be deleted (they are incompatible). You will need to recreate them. The 
default setup will also be reset to factory default values.

Update Using USB Stick and Chassis
1.	 Download the .zip file and extract and copy the .ajas file to a USB stick.

2.	 Disconnect the HDR Image Analyzer 12G from the internet.

3.	 Manually power cycle unit two times, waiting until UI is ready for use each 
time.

4.	 Insert the USB stick into a rear USB port on the HDR Image Analyzer 12G 
chassis.

5.	 Go to Help > Update Analyzer.

6.	 Select the downloaded .ajas file and click Select File. 

7.	 The firmware will be copied to the HDR Image Analyzer 12G, and when 
complete the message "Preparation Complete, please restart Analyzer" 
appears.

8.	 Click on the Analyzer > Application Restart menu item to complete the 
update, which might involve several system restarts. A screensaver will be 
displayed with an "Updating Do Not Shutdown" precautionary message. 

https://www.aja.com/products/hdr-image-analyzer-12g#support 
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IMPORTANT:   Do not power off the system during the firmware update. Please be patient, 
this upgrade could take up to 20 minutes. Interrupting the upgrade process will 
have adverse effects.

9.	 When done, an "Update complete. Auto Shutdown in 20 seconds" message 
appears, and the chassis will power down.

10.	Power up the HDR Image Analyzer 12G using the front panel power button. 
One or more end user license agreement screens will appear. Scroll down 
and click on the Accept button for each agreement.

11.	 The HDR Image Analyzer 12G application will then launch, ready for 
operation.

Update Using Web Browser
Since v1.1, HDR Image Analyzer 12G supports software update using a Web 
Browser running on a separate network connected computer. 

1.	 Download the .zip file and extract the .ajas file to a location on a network 
connected computer.

2.	 Disconnect the HDR Image Analyzer 12G from the internet. 

3.	 Manually power cycle unit two times, waiting until UI is ready for use each 
time. 

4.	 Open a web browser on that computer and enter the IP address of your 
HDR Image Analyzer 12G. A web page will be displayed.

5.	 Go to the Firmware menu and click Choose File.

6.	 Navigate to the saved location on the computer, select the .ajas file, click 
Open, and then click Upload. 

NOTE:	 Proper display of status messages will require reloading the web page. While the 
HDR Image Analyzer 12G is restarting, the web page will not be connected or 
updated. After each restart completes, refreshing the web page will reconnect 
and display the current progress of the update, with prompts for actions to take. 

7.	 The software will be uploaded and installed, with status messages 
indicating the progress, and the HDR Image Analyzer 12G may restart several 
times during the upgrade.

IMPORTANT:   Do not power off the system during the firmware update. Please be patient, 
this upgrade could take up to 20 minutes. Interrupting the upgrade process will 
have adverse effects.

8.	 When the installation completes the HDR Image Analyzer 12G may reboot 
automatically.

NOTE:	 If updating from v2.0 to 3.0 firmware , a "System shutdown is required to 
complete updates" message appears. Restart the HDR Image Analyzer 12G's 
computer to shut down the system, and then power up the 
HDR Image Analyzer 12G using its front panel power button.

9.	 One or more end user license agreement (EULA) screens will appear. Scroll 
down and click on the Accept button for each agreement.

10.	The HDR Image Analyzer 12G application will then launch, ready for 
operation.

Licensing
The HDR Image Analyzer 12G comes with an internal license already activated. No 
user involvement is required for licensing, other than accepting end user license 
agreements.



HDR Image Analyzer 12G ﻿ v3.0	 11	 www.aja.com

﻿

Chapter 3 – HDR Image Analyzer 12G GUI

Overview
HDR Image Analyzer 12G is a real time video analyzer for QC, Mastering, 
Grading and Broadcast. The simple, easy to use graphical user interface 
(GUI) features unique options designed specifically for HDR work. When the 
HDR Image Analyzer 12G hardware starts up, the GUI automatically launches.

HDR Image Analyzer 12G interface provides a Quadrant layout for viewing your 
tools and footage as you work. Full Screen and Multiple Channel views are also 
available. 

Quick key shortcuts provide pre-configured common layouts for how your 
tools and views are presented. For further customization, you can also choose 
a particular tool to be shown in any of the quadrants by either right-clicking on 
the quadrant itself and choosing your preferred tool, or by accessing quadrant 
choices from the Analyzer > Tools menu.

After you have created a layout view matching your work requirements, it can be 
saved as a unique Setup for easy reuse.

Input Source Routing and Views
In addition to single input video analysis of quad-link 8K/UltraHD2 or 4K/
UltraHD signals, HDR Image Analyzer 12G version 3.0 firmware supports the 
simultaneous analysis of four input Channels, up to 4x single-link 4K/UltraHD. 
The four inputs can be different video formats (for example, 4K, UltraHD, 2K, HD) 
and even different compatible frame rates (for example, 59.94, 29.97, 23.98). The 
Video>Input Setup dropdown menu is used to select which of these operating 
modes the HDR Image Analyzer 12G will use.

In Four SDI Inputs mode, each input signal can be routed to one of four Channels, 
which can then be selected for image viewing or assigned an analysis tool and 
displayed full screen, or in any quadrant, creating an analysis View. Once you have 
created an arrangement of images and tools, you can save that View as a Setup 
for easy recall. 

HDR Image Analyzer 12G version 3.0 has also added support for the analysis of 
NDI streams present on the network. Each detected NDI stream can be routed 
to any of the four Channels, assigned to an analysis tool in a View and saved as a 
Setup, the same as an individual SDI input. 

Four Channel Input Analysis
HDR Image Analyzer 12G version 3.0 firmware supports the simultaneous analysis 
of four input Channels, up to 4x 4K/UltraHD. The four inputs can be different 
video formats (for example, 4K, UltraHD, 2K, HD, and even different compatible 
frame rates (for example, 59.94, 29.97, 23.98).

A Four Channel View is available to monitor each signal simultaneously, with each 
Channel showing the image, waveform, and vectorscope, plus audio metering 
(see "Four Channel View" on page 14).

A Quadrant View is also available that can be customized. When analyzing 
multiple Channels, each quadrant is individually configurable to present an 
analysis tool for any of the four Channels. In Figure 3, two different Channels are 
examined by two different tools simultaneously.
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Figure 3.  Quadrant View of Two Input Channels Analyzed With Different Tools

Views
The Analyzer uses screen layouts with either a Quadrant view, Full Screen view, or 
Four Channel view.

Quadrant View
Each screen quadrant can be configured to display the image being examined, or 
display any of the available analysis tools for any of the HDR Image Analyzer 12G's 
Channels (Figure 4).

Figure 4.  Quadrant View Example

The tool or image in each quadrant can be selected by right-clicking on that 
quadrant to open a drop-down selection menu (Figure 5). 
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Figure 5.  Right-Click Configuration, Lower Right Quadrant

After the selection that quadrant will display the new image or tool (Figure 6).

Figure 6.  Alternate View After Right-Click Configuration

 

Quadrants can also be configured using the Analyzer menu drop-down lists.

Full Screen View
In Full Screen View, the image being examined, or some of the selected 
measurement tools, can be displayed full screen. 

Figure 7.  Full Screen View Example, Waveform RGB Color
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Four Channel View
Pressing the Shift-Enter keystroke combination when multiple Channels are active 
displays all the Channels side by side simultaneously. Pressing Shift-Enter again 
restores the previous view. This viewing mode can also be turned on and off via 
the Analyzer>Tools>Views>Four Channel View menu selection. This view is not 
customizable.

Figure 8.  Four Channel View Example, Analysis of Four Inputs

 

Drop-Down Menu Navigation
A top menu bar appears when the cursor is moved to the top of the screen. These 
menus can be used to select layouts and configure settings. Clicking on a menu 
name opens that menu. 

Pressing the ESC key also displays the drop-down menus.

The menu item with a "+" indicates the current setting. 

Figure 9.  Selecting Colorspace Using Drop-Down Menu
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When a drop-down menu is displayed:
•	 The left and right arrow keys can be used to move to an adjacent menu, or 

open an additional parameter menu for the current menu selection.
•	 The up and down arrow keys move the selection up or down that drop-down 

menu.
•	 Pressing the TAB key when the top menu bar is present selects the next drop-

down menu to the right. Shift+TAB selects the drop-down menu to the left.

NOTE:	 When the menu bar is not displayed, the TAB key opens the Settings screen. See 
"Settings Screen" on page 40 for more information.

Selecting Views with Keyboard
When a drop-down menu is not open, the computer keyboard can be used to 
activate layouts and to access the Settings and Multiple Channel screen displays. 
Keystrokes for each shortcut are listed in the drop-down menus.

When variations of an image or tool are available, the keyboard shortcuts will 
display the currently selected variation by default. 

Table 1.  Analyzer Mode Function Key Actions

F1 Show/Hide Full Screen View Waveform.

F2 Show/Hide Full Screen View Gamut. 

F3 Show/Hide Full Screen View Video Image. 

F4 Show/Hide Full Screen View Vectorscope. 

F5 Cycles only Q1 through Image, Waveform, Gamut, 
Vectorscope, and Audio views.

F6 Cycles only Q2 through the five views above.

F7 Cycles only Q3 through the five views above.

F8 Cycles only Q4 through the five views above.

Table 2.  Current View Shortcuts

CTRL+F5 Cycles Q1 tool variant. The Image display cycles through 
Brightness and Gamut tools, and the Waveform display 
cycles through Luminance and Color tools. 

CTRL+F6 Cycles Q2 tool variant as above.

CTRL+F7 Cycles Q3 tool variant as above.

CTRL+F8 Cycles Q4 tool variant as above.

CTRL+v Toggle on/off magnification of the Vectorscope display. 

CTRL+NumPad 
Plus Sign

Increase Analyzer display gain.

CTRL+NumPad 
Minus Sign

Decrease Analyzer display gain.

CTRL+ENTER Reset Analyzer gain.

CTRL+w Apply a 4x magnification to the Waveform display.
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Table 3.  Capture Image Shortcuts

Alt+1 Capture on Channel 1 and show it immediately.

Alt+2 Capture on Channel 2 and show it immediately.

Alt+3 Capture on Channel 3 and show it immediately.

Alt+4 Capture on Channel 4 and show it immediately.

Shift+1 Show Live input on Channel 1.

Shift+2 Show Live input on Channel 2.

Shift+3 Show Live input on Channel 3.

Shift+4 Show Live input on Channel 4.

CTRL+NumPad 1 Recall captured image on Channel 1.

CTRL+NumPad 2 Recall captured image on Channel 2.

CTRL+NumPad 3 Recall captured image on Channel 3.

CTRL+NumPad 4 Recall captured image on Channel 4.

Table 4.  Additional Shortcuts

CTRL+F10 Sets Colorspace to SDR Rec 709.

CTRL+F11 Sets Colorspace to HLG Rec 2020.

CTRL+F12 Sets Colorspace to HDR Rec 2020. 

CTRL+space Toggles Single Line Mode ON and Off.

Table 5.  Screen Display Shortcuts

TAB Displays the Settings Screen, with Tabs.

Shift+Enter Shows the Four Channel Full Screen View Waveform.

CTRL+p Show/Hide Performance window.

Analyzer Modes
The waveform, histogram, and vectorscope are a form of oscilloscope and are 
used to monitor video brightness, contrast, hue, and color saturation.

•	 The waveform displays the luminosity or brightness and contrast of the pixels 
in the video frame, with the top of the y-axis indicating a high luminosity level, 
and the bottom indicating a low luminosity level.

NOTE:	 Waveform views can be magnified 4x using the Waveform Zoom control. Use the 
mouse to move up and down the display.

•	 The histogram shows the number of pixels in relation to a given list of 
luminance, or colors in a specific colorspace.

•	 The vectorscope displays values for hue and color saturation. The color 
saturation of each pixel in the video frame is shown, with the middle of the 
circle indicating a lower saturation level, and the edge of the circle indicating 
a higher saturation level. Hue is represented by placement in the 360 degree 
angle of the circle.

NOTE:	 The Vectorscope view can be displayed at either a 75% or 100% size (the 
percentage changes the graticules on the Vectorscope, not the rasterized image), 
and can be magnified with the Vectorscope Zoom control.

•	 The gamut screen shows a CIE xy gamut graph reporting the color values 
present in the image, with a graticule showing the limits for various standards 
(709, P3, 2020).

Several Analyzer view modes are available.
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Figure 10.  Waveform Luminance Mode

 

Waveform showing only luminance (Y) and no color information. Each pixel on 
the graph shows the frequency of the corresponding luminance value in the 
given column. Higher luminance value means lighter image content, lighter pixel 
means higher frequency of that luminance value.

Figure 11.  Waveform Lumi Color Mode

 

Waveform showing both luminance and color information. Here, in addition 
to the Waveform Luminance mode, the graph is colored according to color 
information. The hue and saturation of a pixel shows the sum of the dominant 
colors having the corresponding luminance value.

Figure 12.  Waveform Color Mode
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Waveform showing the RGB channels superposed in one graph.

Figure 13.  Waveform RGB Color Mode

 

Waveform showing the RGB channels in a split view, where each graph is shown 
in its respective color.

Figure 14.  Waveform RGB Mode

 

Waveform showing the RGB channels in a split view, where each graph is shown 
in monochrome. 

Figure 15.  Waveform YCbCr Mode

 

Waveform showing luma (Y), blue minus luma (Cb), and red minus luma (Cr) in a 
split view.
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Figure 16.  Waveform YRGB Mode

 

Waveform showing luminance and RGB channels in a split view, where each color 
channel graph is shown in its respective color. 

Figure 17.  Histogram Luminance Mode

 

Histogram Luminance is showing the frequency of luminance values throughout 
the current image content. Left-hand part is for darker, right-hand part is for 
lighter image content.

Figure 18.  Histogram Color YCbCr Mode
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Histogram Color showing the frequency of RGB channel values throughout 
the current image content, superposed. For each channel, the left-hand part 
represents image content for “0” or Black, while right-hand part represents image 
content for "1" and White. The 0-1 range is a scale, also represented as code 
values: (0 = 0,0,0 and 1 = 1023,1023,1023) in 10 bit code value for R, G & B.

Figure 19.  Gamut Mode (CIE xy Graph) with Gamut Error

 

This mode displays a CIE xy Gamut, showing various output referred color gamut 
standard limits, and also has Brightness and Gamut bars.

Brightness and Gamut Bars

This view also contains two bars: the brightness bar on the left indicates the 
brightest pixel detected, the gamut bar on the right shows if the colors are within 
the legal color gamut. See "CIE xy Gamut View" on page 33 for more information.

Figure 20.  Vectorscope with markers indicating 75% values

  

Vectorscope is showing the hue and saturation of all pixels throughout the 
current image content. The middle of the circle indicates a lower level of 
saturation, while the edge of the circle indicates a higher level of saturation. The 
brightness of the graph shows the frequency of the respective color in the image 
content. 
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Figure 21.  Vectorscope with markers indicating 100% values, Vectorscope Aid

 

Skin Tone Line
A skin tone line is also available on the Vectorscope graticule, adjustable using 
the Skin Tone X and Y controls in the Settings menu.

Vectorscope Aid
A Vectorscope Aid feature is available in the Settings menu, which draws a gray 
bounding area around the chroma on the Vectorscope, which can be useful when 
trying to examine individual pixels

NDI Support
HDR Image Analyzer 12G version 3.0 firmware supports receiving Full NDI 4K/
UltraHD/2K/HD signals over an Ethernet connection. These NDI signals can be  
run through the HDR Image Analyzer 12G's robust image analysis toolset as they 
would with an SDI signal. No external conversion technology is required, offering 
space, power, and cost savings. 
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Figure 22.  NDI Source Selection Example.

Any NDI stream detected on the network will be displayed on the NDI dropdown 
list. If a stream is not actually carrying video, that NDI source can still be selected, 
but will not show any image. If video is present, it will be shown with the 
appropriate video format information. 

Dolby Vision Analysis Capabilities
HDR Image Analyzer 12G v3.0 introduces Dolby Vision dynamic metadata 
inspection and presentation, with support for Dolby Vision v4.0 and v2.9, through 
automatic detection. The improvement allows users to take in an SDI signal with 
embedded Dolby Vision metadata and view the Dolby Vision metadata in various 
ways. For example, L1 metadata is presented visually in the waveform as NIT 
markers and all of the metadata is displayed in the Dolby Vision metadata analysis 
tool as readable text. It can be seen in real-time on a scene-by-scene/shot-by-
shot basis or as the metadata is changed upstream of the HDR Image Analyzer. 
Helping to accelerate color and QC workflows, this new feature addition gives 
professionals greater confidence that they’ve generated and validated the correct 
Dolby Vision metadata.
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Figure 23.  Dolby Vision Analysis, Lower Right Quadrant 

Framing Guides
HDR Image Analyzer 12G supports two framing guides, Safe Title and Safe Action. 
Enabling "Safe Area on Image" displays the guides configured in the SAFEAREA 
sub-page of the Settings screen. You can display either the Safe Title, Safe Action, 
or both boundaries. The CTRL+s hotkey combination enables and disables the 
framing guide display. 

Figure 24.  Framing Guides
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Timecode on Image
The timecode is captured from several areas including the SDI and may be 
displayed on the image by selecting the Window › Timecode on Image menu 
option.

Figure 25.  Timecode on Display Image (Lower Right Corner of Quadrant) 

 

Audio Monitoring
Any quadrant of the HDR Image Analyzer 12G GUI can display one of the audio 
monitoring screens. In the following examples the various tools are shown in the 
lower right quadrant (Q4).

Audio Phase Meter
Analyzer supports an audio phase meter which can be configured to display 
either two channel (stereo) or eight channel (surround) audio. When configured 
to display two channels, channels 1-2, 3-4, 5-6, or 7-8 may be displayed. When 
configured to display 8 channels, channels 1-8, or 9-16 may be displayed.
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Figure 26.  Audio Phase Meter

 

Audio Level Meter
Analyzer supports an audio level meter with up to 16 channels which can be used 
to monitor audio levels and also display peak dB levels. You can keep the highest 
peak displayed with the Audio Infinite Peak Hold feature available in the Settings/
QC screen. 

Figure 27.  Audio Level Meters

Pixel Picker
The HDR Image Analyzer 12G GUI can display Pixel Picker information. See "Pixel 
Picker" on page 36 for more information.
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Figure 28.  Pixel Picker Quadrant View

  

Log Data
When Log is selected for a quadrant, the current log data is displayed. This 
information can be saved to log files. See "Logging" on page 39 for more 
information. 

Figure 29.  Log Data Quadrant View

 



HDR Image Analyzer 12G ﻿ v3.0	 27	 www.aja.com

﻿

Info Page
When Info is selected for a quadrant, useful information about the current 
HDR Image Analyzer 12G settings is displayed.

Figure 30.  Info Page Quadrant View

 

Other Features
Other configuration options are available in the various HDR Image Analyzer 12G 
menus. See "Chapter 6 Menu Reference" for additional information.
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Chapter 4 – Using HDR Image Analyzer 12G

HDR Image Analyzer 12G Setups
The Setup menu of the top menu bar is used to create, open, save, and reset 
Setups of views and parameter settings.

Figure 31.  Setup Menu

About Setups
When a Setup is created and/or saved, the current View settings are saved to 
that named setup. Each saved Setup includes the Channel configuration, video 
settings, view settings, analyzer tool settings, and the configured values on the 
settings screen (except for NETWORK settings, which are unaffected by Setups).

NOTE:	 If a LUT file that was used as part of a Setup is deleted, it will not be restored when 
a Setup that used it is opened. 

When a Setup is Opened, those saved View and Settings values are recalled. 
Changing those settings on the UI does not change the previously saved settings, 
unless you save them again. 

NOTE:	 The manner in which Setups are saved and recalled has significantly changed in 
v3.0 from earlier HDR Image Analyzer 12G firmware versions. 

Setup Controls

Create Setup
Opens a window to name and create a setup of the current View and Settings 
parameters.
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Open Setup
Displays a list of the current Setups for selection. 

Delete <Name> Setup
When a Setup has been recalled, you can delete it with this choice. 

Save <Name> Setup
Saves the current View and Settings parameters for this Setup.

Reset <Name> Setup
Restores the last saved settings for this Setup. 

Video Menu
The Video drop-down menu of the top menu bar is used to define the 
characteristics of the SDI video input signal(s) being analyzed, select single or 
four Channel input, and can be used to capture and recall still video images for 
detailed analysis. 

Figure 32.  Video Menu

 

NOTE:	 If Auto Detect is On, the HDR Image Analyzer 12G will automatically select (if 
possible) the incoming video's Resolution, Colorspace, Transport, and Square 
Division settings.

Video Input Setup
HDR Image Analyzer 12G supports two modes of operation, Quad-link SDI Input 
mode or Four SDI Inputs mode. The operating mode affects how the four SDI 
Input connectors on the HDR Image Analyzer 12G chassis are used.
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Quad-link SDI Input
Quad-link mode is required for legacy 4K/UltraHD signals that utilize four 3G-SDI 
links with either 2SI or SQD pixel mapping, or 8K/UltraHD2 signals which require 
four 12G-SDI links, usually with 2SI pixel mapping (early products may have used 
SQD, however). In this mode all four SDI input connectors are used for one SDI 
input source. NDI sources can also be selected for additional analysis. 

SDI inputs 2, 3, and 4 are unavailable when operating in this mode. The only input 
signal selection available in this mode is either SDI 1, or an NDI signal stream 
present on the network. 

Four SDI Inputs
Four Inputs mode allows analysis of up to four SDI input signals simultaneously. 
Only single link formats are supported, and all four SDI inputs 1, 2, 3, and 4 and 
any NDI streams are all available to be selected for analysis. Any combination of 
four inputs, SDI or NDI, can be accessed for analysis, and these sources, and tools 
for these sources, can be assignment to a Quadrant view or Full Screen view.

Selecting Analyzer>Tools>Four Channel View (or use the Shift+Enter keyboard 
shortcut) presents a four Channel view, showing each image accompanied by a 
waveform RGB color, vectorscope, and audio tool.

Resolution
A drop-down menu permits selecting a resolution to manually match the 
incoming video being analyzed. Select from:

•	 720p
•	 HD
•	 2K
•	 UHD
•	 4K
•	 UHD2
•	 8K

Colorspace
A drop-down menu permits selecting from YCbCr 10 bit, RGB 10 bit, or RGB 12 bit 
colorspaces to manually match the incoming video being analyzed. Select from:

•	 YCbCr 10 bit
•	 RGB 10 bit
•	 RGB 12 bit
•	 RGB Range is Legal

Transport
A drop-down menu permits selecting the SDI transport to manually match the 
incoming video being analyzed. Select from:

•	 Single Link
•	 Dual Link
•	 Quad Link
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4K Pixel Mapping
A drop-down menu permits selecting the pixel mapping of incoming SDI video. 
Select from:

•	 SQD - Square Division
•	 2SI - Two Sample Interleave

2SI LFR and HFR Input
For LFR (Low Frame Rate) 2SI video the Analyzer only uses SDI input 1 and 2 (four 
wire LFR 2SI is not supported at this time). 

For HFR (High Frame Rate) 2SI video all 4 SDI inputs are used.

Auto Detect Options
The Auto Detect Options setting is used to make the HDR Image Analyzer 12G 
automatically select the number of incoming video signals to be used depending 
on the detected video, or to force the use of only the first BNC input connector, or 
to  force the use of all four input connectors. The auto detection is based on the 
VPID video payload identifier (SMPTE 352M).

Auto Detect - HDR Image Analyzer 12G automatically detects incoming video 
and uses either one link, or four links as appropriate. 

Forced 1x SDI Connection Mode - Forces use of only BNC input connector one.

Forced 4x SDI Connection Mode - Forces use of all four input BNC connectors.

Input Setup
This setting determines whether the HDR Image Analyzer 12G operates in Single 
Channel or Four Channel Mode.

Quad–link SDI Input - The unit operates as a single input analyzer.

Four SDI Inputs - The unit allows analysis of up to four inputs. 

NOTE:	 In either operating mode, the Shift+Enter keyboard shortcut toggles to and from 
a Four Channel view layout. When operating in Four Channel mode all four 
Channels are displayed. When operating as a single Channel analyzer, only the 
first Channel will be displayed. 

Screenshot
The Screenshot menu lets you capture the current Analyzer UI screen displayed 
on the connected computer. Screenshots are saved as .png files to the local host 
computer, and can then be copied into a different folder (for example an attached 
USB flash drive).

Save Screenshot
Captures the current Analyzer UI screen. You can also use the CTRL+e hotkey.
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Copy Screenshots
Copy All Screenshots - Opens a file browser window allowing you to select 

the drive and folder into which all the currently captured screenshots will be 
copied.

Copy Today's Screenshots - Copies only the screenshots captured today.

Copy All Except Today's Screenshots - Copies all captured screenshots except 
those captured today.

Delete Screenshots
Delete All Screenshots - Deletes all currently captured screenshots. Does not 

affect screenshot files that have been copied into another folder.

Delete Today's Screenshots - Deletes only the screenshots captured today.

Delete All Except Today's Screenshots - Deletes all captured screenshots 
except those captured today.

Analyzer Colorspace and Range
You can find the analyzer range configuration options in Analyzer > Analyzer 
Colorspace menu.

The Analyzer supports Camera Log, and SDR and HDR (HLG and PQ) colorspace 
modes. Select the appropriate option from the Analyzer > Analyzer Colorspace 
menu that matches the current image.

Auto HDR Mode Change
This parameter can be used to make the HDR Image Analyzer 12G automatically 
configure the Transfer Characteristic and Colorspace settings, based on the 
VPID of the incoming SDI signal.

NOTE:	 Not all signals carry HDR related VPID settings, and so may default to SDR Rec 
709. 

Camera Log Analysis
Several original camera log curves are supported for processing media in the 
original capture colorspace. Supported formats are the following:
•	 ARRI LogC WideGamut
•	 ARRI LogC4 WideGamut4
•	 CanonLog2
•	 CanonLog3
•	 Panasonic VLog/VGamut
•	 Red WideGamut/Log3G10
•	 Sony SLog3/BT2020
•	 Sony SLog3/SGamut3
•	 Sony SLog3/SGamut3Cine
•	 ACEScct

For scene referred input (Camera Log colorspace modes) CIE xy Gamut Graph 
values are clipped to the primaries of the colorspace.
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In these modes, the waveform graticules are displayed in camera stops. To set 
up the base level and the warning level, adjust the following settings in the QC 
section of the Settings page (open with Tab):

CameraBaseGrey - Base grey level in nits; the 0 exposure line will be drawn at 
this level

CameraWhiteStopsOverGrey - Brightness warning level; it stops over base 
level

SDR Analysis
For working with SDR gamma encoded broadcast or cinema signal, set the 
Analyzer Range to SDR. Possible color primary options are the following:

•	 Rec709
•	 P3 DCI
•	 P3 D65
•	 Rec2020
•	 XYZ DCI

HLG Analysis
HLG mode supports variable Hybrid Log-Gamma color encoding. In this 
mode, code values range from 0 to 1 and pixels do not have a specific nit level 
interpretation. Possible color primary options are the following:

•	 Rec709
•	 Rec2020 (with gamut warning for colors outside of P3)

NOTE:	 The settings QC tab has a Gamut Warning parameter that allows setting when 
the HDR Image Analyzer 12G will trigger out-of-gamut warnings. You can choose 
Rec 709, P3, Rec2020 or none.

HDR Analysis
HDR mode supports High Dynamic Range analysis. Peak brightness values above 
the maximum allowed nit level are indicated in red on all graphs.

Possible color primary options are the following:
•	 Rec709
•	 P3 D65

NOTE:	 By default, the peak brightness threshold is set to 1000 nits according to the 
HDR10 standard. When working with PQ masters of higher peak brightness, the 
corresponding maximum brightness needs to be adjusted on the QC section of 
the Settings page (open with Tab).

•	 Rec2020 (with gamut warning for colors outside of P3)
•	 XYZ DCI
•	 XYZ D65

CIE xy Gamut View
The CIE xy Gamut View can be used to check the encoded colors on a standard 
CIE xy graph, and to see if they are within the valid color range in case a specific 
gamut constraint is to be enforced. This is relevant when working in the Rec2020 
colorspace, so the operator can identify that the colors are outside of the P3 
gamut. This is a requirement for several currently popular delivery formats.
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Figure 33.  CIE xy Graph with Brightness and Gamut Bars

This view also contains two bars. Illegal colors are indicated when a bar is colored 
red.

The bar on the left is the brightness bar that indicates the brightest pixel detected 
on the actual frame. When properly configured, an inner vertical bar on the left 
with a nits value shows the Frame Average Light Level (FALL) of the current frame, 
which allows the operator to inspect the average brightness of the image.

The bar on the right is the gamut bar that shows if the colors of the actual frame 
are within the configured Gamut Warning parameter and tolerance. 

The maximum values are calculated using the Tolerance parameters available in 
the Settings Screen. HDR Image Analyzer 12G uses thresholds when detecting 
these extremes, so when using the default settings a few pixels are allowed to 
exceed the legal limits without triggering a warning.

NOTE:	 Cumulative maximum values can be displayed on the Brightness and Gamut bars 
using the Log > Show Maximum Values parameter.

YCbCr Matrix
For the purpose of showing YCbCr components in various graphs (such as the 
vectorscope or the waveform YCbCr), the result image is converted to the YUV 
space. Select from the following formats for the specific matrix transformation:

•	 Rec2020
•	 Rec709
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Figure 34.  Signal Analysis with CIE xy Gamut Graph and Vectorscope

NOTE:	 The above settings will be reflected in the CIE xy graph and the gamut meter.

White Point Compensation
White point is a marker on the CIE graph. White point compensation D65, 
however, is an option to change processing. Thus, if you are in XYZ Gamma2.6 
colorspace (Digital Cinema), you can change the Vectorscope and Waveform 
processing so that the balanced white would be D65 instead of DCI. By default, 
DCI white would be in the center of the Vectorscope, and DCI white would have 
the same level in the three channels of the waveform. If you turn on White Point 
Compensation to D65, then D65 white would be in the center of the Vectorscope, 
and D65 white would have the same level in the three channels.

•	 The White Point Compensation parameter in the Analyzer menu turns 
compensation On and Off, which will change the analysis of the incoming 
video.

•	 The White Point parameter simply displays a box for either D65 or DCI on the 
CIE graph, and does NOT alter the analysis of the incoming video. 

False Color
You can check for illegal or near-illegal brightness and gamut levels by enabling 
the False Color mode. The available False Color display modes are the following:

•	 Brightness
•	 Brightness Warning
•	 Gamut
•	 Gamut Warning

In the Warning modes, pixels that are too bright or out-of-gamut are colored red. 
Values at 90% of threshold are orange. The rest of the pixels are displayed in gray 
scale.
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Pixel Picker
The Pixel Picker is always active. With a left click of the mouse you can pick any 
pixel on the image. The Pixel Picker view provides an extra precision view with 
per-pixel granularity.

Figure 35.  Pixel Picker, Lower Right Quadrant

In Four Channel Input mode, the selected pixel values are displayed at the same 
location on all input displays. The source pixel value of the actually selected pixel 
is displayed with vertical and horizontal lines and pixel values. The corresponding 
pixel value on the other Channels are indicated with only horizontal lines, and 
dimmed values (Figure 36). 

Figure 36.  Pixel Picker, Four Channel View Mode

 

Pixel Picker Modes
From the menu the operator can choose how to inspect the pixel color values. 
The options are:

Hexadecimal mode - Displays the hex code values of the pixels.
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Decimal mode - Displays the decimal code values of the pixels.

Nit value mode - Displays the pixel brightness in nit level.

Single Line Mode
Single Line Mode limits the analysis to a single horizontal line of video. This mode 
can be used by a QC operator to verify blanking. 

Figure 37.  Single Line Mode

 

The line being analyzed is indicated with a contrastingly colored line, and the 
number of the line is shown on the upper right.

Single Line Mode is turned on and off with the Analyzer Mode menu, or with the 
CTRL+space hotkeys. Additionally the hotkey CTRL + Up/Down Arrow moves the 
single line mode up and down one line at the time.

LUTs

Overview
Lookup Tables (LUTs) allow the mapping of colors between colorspaces. 

The HDR Image Analyzer 12G allows external Lookup Tables (LUTs) to be used for 
two different purposes:

•	 A Display LUT is only applied to the image being shown and does not affect 
the actual analysis of the pixel values. This can allow an operator to look at a 
correct image on a display device that does not match the current video signal 
type.

•	 A Scope LUT is applied to the video signal being processed, so all scopes, 
waveforms etc. will be based on the remapped image. 

No external LUTs are provided with the HDR Image Analyzer 12G. Users can create 
and load custom LUTs, if desired, provided they are formatted as either a *.cube or 
*.3dmesh LUT file.
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LUT File Management
LUT files are loaded into and deleted using the Setup > Manage LUTs menu 
(Figure 38). One easy way to install LUT files is to copy them to a USB stick, insert it 
into the HDR Image Analyzer 12G, and load them from that media or to load them 
through the Web UI.

NOTE:	 The HDR Image Analyzer 12G will automatically restart after a LUT has been 
loaded.

Figure 38.  Manage LUTs Menu

 

LUTs are not active until selected for use as either an Analyzer Scope LUT or an 
Analyzer Display LUT, using the Analyzer menu selections (Figure 39). 

Figure 39.  Analyzer Display LUT Menu
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Analyzer Scope LUT

Generally the No LUT Analyzer Scope LUT setting should be used to maintain the 
correct color analysis.

Display Scope LUT

Generally the Auto Analyzer Display setting should be used, which enables 
HDR Image Analyzer 12G to use its internal, calibrated LUTs for proper display. 

Logging
The HDR Image Analyzer 12G supports two types of logging. System Logs 
can help with HDR Image Analyzer 12G troubleshooting, while QC Logs relate 
to Channel analysis (for example, out of gamut warnings).  Log files include 
information for all four Channels. 

The HDR Image Analyzer 12G can detect the events below, with time stamps, 
include that information in a log file, and display the results on screen:

•	 Gamut violations of the current colorspace.
•	 For HDR, P3 Gamut violation if HDR Colorspace is set to Rec2020.
•	 For HDR, Brightness violation. Max brightness for HDR is configured in the 

Settings > QC tab.
•	 Timecode break

Figure 40.  Logging with Show Maximum Values Selected

  

A new log file can be created by starting a QC session from the Log drop-down 
menu:

•	 Start Log to File (CTRL+l)
•	 Clear Log Data (CTRL+d)

You can also select the timecode or session clock to be used in the log:
•	 Log Window Timecode 
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Settings Screen
Advanced features are available on the Settings screen, allowing customization 
of the HDR Image Analyzer 12G GUI for special purposes. The Settings screen is 
accessed by pressing the TAB key when the top menu line is not displayed. Click 
on the desired tab to display the available parameters.

GUI Tab
Figure 41.  Setting Screen, GUI Tab

 

GUI HDR Mode
The Settings/GUI menu lets you choose between SDR and HDR10 (use HDR10 if 
you have an HDR enabled DisplayPort monitor).

QC Tab
These advanced settings are for experienced colorists and QC professionals, 
permitting customization of the values used for analysis.

The QC parameters are saved in Setups. If you Reset a Setup, all values in QC are 
returned to Defaults.

Figure 42.  Setting Screen, QC Tab Scrolled Up
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NOTE:	 The lower QC parameters may not initially be visible. Scroll down the screen to 
see it, using the mouse's scroll wheel or by holding down right-click and moving 
the mouse up and down.

The parameters are largely self explanatory, but the following special features are 
available.

Additional Marker for HDR
This control lets you add up to three custom level marker lines to the Waveform 
view. As an example, if mastering for 600 nits Rec2020, you may want to add a 
“600” line for visual reference.

•	 Range 100.0 to 10,000.0 
•	 Enter -1 to hide the custom level marker line

Gamut Warning
The Gamut Warning parameter allows setting when the HDR Image Analyzer 12G 
will trigger out-of-gamut warnings. You can choose from:

•	 Rec709
•	 P3
•	 Rec2020
•	 Off

Skin Tone
You can adjust the location of the skin tone line on the vectorscope display by 
entering X and Y CIE coordinates. The default location of the skin tone line varies 
depending on the colorspace being used. 

Dolby Vision L1 Tolerance
Allows you to specify the percentage of the brightest pixels to be ignored for 
Dolby Vision Level 1 metadata analysis.

Audio Infinite Peak Hold
Enabling the display of the peak audio hold indicator infinitely on the level meter.

Audio Level Warning
Customizes the audio level warning threshold, which can vary depending on the 
country standard.

Vectorscope Aid
When On, draws a gray bounding area around the chroma on the Vectorscope, 
which can be useful when examining individual pixels.

NETWORK Tab
The Network settings are used to configure the two network interface cards 
(NICs) installed in the HDR Image Analyzer 12G chassis. 
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Figure 43.  Setting Screen, Network Tab, Scrolled Up 

NOTE:	 The lower Network Settings parameters may not initially be visible. Scroll down 
the screen to see it, using the mouse's scroll wheel or by holding down right-click 
and moving the mouse up and down.

Figure 44.  Setting Screen, Network Tab, Scrolled Down 

Domain and Host Names
By default the HDR Image Analyzer 12G is configured for DHCP operation. If a 
DHCP server is found on power up, these fields will be filled in automatically. You 
can change these names if you need to adjust the configuration for your network 
environment.

NOTE:	 Changing the Domain Name and/or Host Name requires a system reboot.
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Password Fields
IMPORTANT:   On the very first HDR Image Analyzer 12G startup, a unique password is 

generated when the serial number is entered in the Web UI. The password is 
"hdria<last four digits of serial number>" (for example, "hdria1234"). The default 
HDR Image Analyzer 12G User Name is "kiosk", and it cannot be changed by the 
user.

The password is required for login and Remote Desktop operation. You can 
change the default password with the Password and Confirm Password fields. 

NOTE:	 You must exit Setup screen (press Tab) to enable a password change. No system 
or application reset or reboot is required. 

If a Remote Desktop connection was active when the password is changed, that 
connection will immediately be dropped.

Remote Desktop
HDR Image Analyzer 12G supports Remote Desktop, allowing control from a 
separate computer running an RDP client. HDR Image Analyzer 12G supports 
one connection at a time. Connecting via Remote Desktop will disable the local 
computer's Analyzer application or any other remote connection. Control can be 
reacquired at any time from the local computer, or from any remote computer.

Click on the Enabled button on the computer running HDR Image Analyzer 12G. 
After launching your RDP client on a remote networked computer, simply type in 
the IP address of the HDR Image Analyzer 12G and enter your login credentials.

SAFE AREA Tab
These settings are used to customize the Safe Area box displays, including the 
ability to choose which (or both) regions to display.

The Safe Area parameters are saved in Setups. If you Reset a Setup, The Safe Area 
values in QC are returned to Defaults.

Figure 45.  Settings Screen, Safe Area Tab
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Chapter 5 – Web Interface

Overview
The web user interface (Web UI) allows a remote user to configure the 
HDR Image Analyzer 12G from a web browser on a remote networked computer, 
in much the same way a user could from the local main User Interface (UI).

To use the web interface, simply connect the HDR Image Analyzer 12G to your 
network (or directly to a computer) via its rear panel RJ-45 connector, and enter 
its IP address into a browser running on your remote computer.

NOTE:	 The web interface may not actively update the display of information or 
screenshot images when these settings change on the HDR Image Analyzer 12G. 
Reloading the web page will show the latest information.

Web Interface General Description
Figure 46.  Web Interface Menu Screen Example

Main Display
In the center of each screen is the main display showing the status and 
menu selections for the screen you are viewing. The content of the 
HDR Image Analyzer 12G web screens closely mirrors the parameter menus 
displayed on the HDR Image Analyzer 12G user interface. 

Top Line Controls
Three information and control function icons are located at the upper right side 
of the top line of the screen.

Figure 47.  Web Interface Top Line Settings Screen
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Change Theme
The HDR Image Analyzer 12G web UI has two color themes available, Dark and 
Light. Clicking the Change Theme button (half filled circle) toggles the display 
between these two themes. 

Figure 48.  Web Interface, Dark Theme

 

Figure 49.  Web Interface, Light Theme

 

Information Icon
Clicking on the center Information icon on the upper right corner of the web UI 
screen displays information about your HDR Image Analyzer 12G.

Figure 50.  Information Screen

Settings Icon
Clicking on the Settings gear icon on the upper right corner of the web UI screen 
opens a separate Settings screen for selecting a UI theme, and for defining 
remote machine credentials.
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Figure 51.  Web Interface, Top Line Accessed Settings Screen, Local

 

General

Allows you to select a Dark or Light UI theme.

Local - Applies the theme to the local computer's UI.

Global - Applies the theme to the UI of all computers accessing the unit. 

Web Control

Figure 52.  Web Interface, Top Line Accessed Settings Screen, Web Control

 

Because a secure API is used to communicate with Colorfront servers, you need to 
configure credentials when controlling Colorfront software remotely.

NOTE:	 Clicking on the Help (?) icon displays additional proxy information.

Screen Navigation
On the left of each screen is a navigational list of the available screens. Click any of 
these items to jump to that screen. 

•	 Menu
•	 Settings
•	 Info
•	 Screenshots
•	 LUT
•	 Firmware
•	 System Logs
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Web Interface Screens

Menu Screen
Figure 53.  Web Interface Menu Screen Scrolled Up
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Figure 54.  Web Interface Menu Screen, Scrolled Down

The parameters on this screen correspond to the settings available on the local 
or host UI display, albeit arranged slightly differently (see "Video Menu" on page 
29).

Settings Screens
Clicking on the Settings tab will display tabs for the three available Settings 
screens. The parameters on this screen correspond to those available on the UI 
Setting screen (see "Settings Screen" on page 40). 

GUI Screen
Figure 55.  Web Interface Settings, GUI Screen
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QC Screen
Figure 56.  Web Interface Settings, QC Screen

Safe Area Screen
Figure 57.  Web Interface Settings, Safe Area Screen
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Info Screen 
Figure 58.  Web Interface Info Screen

The parameter settings shown cannot be changed on this screen. The settings 
on this screen correspond to the Info page information (see "Info Page" on page 
27). .

Screenshots Screen
The web UI Screenshots screen displays all the screenshots that have been 
captured. The HDR Image Analyzer 12G's main UI does not have a corresponding 
multiple image screen, but commands are available for capturing, saving, and 
deleting screenshots.

Figure 59.  Web Interface Screenshots Screen
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Screenshot Operations
The last captured screenshot (if any) is displayed on the upper left side this 
screen. Each screenshot image has a view button and a download button below 
the lower left side of the image.

Show Button (Four Box Corners)

Clicking on the Show button displays that screenshot in a window.

Download icon (Down Arrow)

Clicking on the Download icon (down arrow) for a screenshot Icon saves that 
screenshot to the downloads folder on your computer. 

Reload Button

This reloads the screen to show all screenshots, similar to refreshing a web page.

Take Screenshot Button 

Clicking on the Take Screenshot button captures the HDR Image Analyzer 12G 's 
current local computer screen (less any displayed drop-down menus).

LUT Screen
Figure 60.  Web Interface LUT Screen

The control on this screen corresponds to "LUTs" on page 37).

Firmware Screen
Figure 61.  Web Interface Firmware Screen
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This screen can be used to update the firmware of your HDR Image Analyzer 12G 
by navigating to a location where a downloaded .ajas file can be chosen for 
installation.

System Logs Screen
Figure 62.  Web Interface System Logs Screen

This screen displays a list of system logs that have been saved. Each log file can be 
viewed, saved, or deleted using the three icons in the right column. The last log 
file shown cannot be deleted.
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Chapter 6 – Menu Reference

Analyzer Menu Guide
Table 6.  Analyzer Menu > Tools

Sub Menu Menu Option 1 Menu Option 
2 Menu Option 3 or Description Keyboard 

Shortcut 

Tools FullScreen Image Full Screen Image with False Color Off  

Full Screen Image with Brightness

Full Screen Image with Brightness Warning

Full Screen Image with Gamut  

Full Screen Image with Gamut Warning

Waveform Full Screen Waveform Luminance

Full Screen Waveform Lumi Color

Full Screen Waveform Color

Full Screen Waveform RGB Color

Full Screen Waveform RGB

Full Screen Waveform YCbCr

Full Screen Waveform YRGB

Full Screen Histogram Luminance

Full Screen Histogram Color

Gamut Full Screen Gamut

Vectorscope Full Screen Vectorscope

Waveform + 
Vectorscope

Full Screen Waveform + Vectorscope

Waveform + 
Gamut

Full Screen Waveform + Gamut

Channel Select Input Channel 1, 2, 3, or 4 for Full Screen

Q1, Q2, Q3, or Q4 Same as Full Screen, but applies only to Quadrant, with added:

Audio Quadrant Audio tool

Pixel Picker Quadrant Pixel Picker tool

Info Quadrant Info Tool

Dolby Vision 
Metadata

Quadrant Display Dolby Vision metadata

Log Quadrant Log tool

Channel Select Input Channel 1, 2, 3, or 4 in Quadrant.

Four Channel View Enable Four Channel View. Shift+Enter

Single Line Mode Enable Single Line Mode. CTRL+space

Move the single line mode analysis up and down one line at the time. CTRL+Up/
Down Arrow
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Table 7.  Analyzer Menu > Analyzer Colorspace, White Point Compensation, 
YCbCr Matrix, White Point

Menu Menu Option 1 Menu Option 2 Menu Option 3 or Description Keyboard 
Shortcut 

Analyzer 
Colorspace

Select from:

All Channels 

Channel 1

Channel 2

Channel 3

Channel 4

Camera Arri LogC Wide Gamut

Arri LogC4 Wide Gamut4

Canon Log2

Canon Log3

Panasonic VLog/Gamut 

Red WideGamut/Log3G10 

Sony SLog3/BT2020

Sony SLog3/SGamut3

Sony SLog3/SGamut3Cine

ACEScct

SDR Rec709 CTRL+F10

P3DCI

P3D65

Rec2020

XYZ DCI

HLG Rec709

Rec2020 CTRL+F11

PQ Rec709

P3D65

Rec2020 CTRL+F12

XYZ DCI

XYZ D65

Auto HDR mode 
change

When On, colorspace is adjusted automatically according to the SDI 
flagging between Rec709, HLG Rec2020 and HDR Rec.

White Point 
Compensation

Off No white point compensation

D65 Apply D65 white point compensation to the analysis.

YCbCr Matrix Rec709 Image is converted to the YUV space, using Rec709.

Rec2020 Image is converted to the YUV space, using Rec2020.

White Point D65 Display a box on the CIE xy graph showing the D65 white point. 
Analysis is not affected.

DCI Display a box on the CIE xy graph showing the DCI white point. 
Analysis is not affected.

Off Hide the white point box on the CIE xy graph.
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Table 8.  Analyzer Mode > Vectorscope Target, Waveform Graticule, Scope and 
Display LUTs, Analyzer Gain, Zoom, Pixels View

Menu Menu Option 1 Description Keyboard 
Shortcut 

Vectorscope 
Target

75%

100%

Waveform 
Graticule

Default

Code Values

Percentage

Analyzer 
Scope LUT 

NoLUT No LUT applied to input signal.

(selection list) Optionally apply a variety of LUTs to the input signal being 
analyzed.

Analyzer 
Display LUT 

NoLUT No LUT applied to display signal.

Auto The LUT is automatically selected in a way that the incoming 
image looks correct on a 709 SDR monitor. 

(selection list) Optionally apply a variety of LUTs to the displayed video 
image, analysis is not affected.

Analyzer Gain Increase Gain Simple increase of display gain. CTRL+NumPad 
Plus Sign

Decrease Gain Simple decrease of display gain. CTRL+NumPad 
Minus Sign

Reset Gain Simple reset of display gain. CTRL+ENTER

Zoom Vectorscope 
Zoom

Apply a 5x magnification to the Vectorscope display. CTRL+v

Waveform Zoom Apply a 4x magnification to the Waveform display. CTRL+w

Pixels View Hexadecimal Color picker displays hexadecimal values

Decimal Color picker displays decimal values

Nits Color picker displays nits (RGB only)

Table 9.  Analyzer Mode > Audio, Timecode, SafeArea

Menu Menu Option 1 Menu 
Option 2 Description Keyboard 

Shortcut 

Audio Phase Meter Channel 1-2 Show audio phase between Ch 1 & 2.

Channel 3-4 Show audio phase between Ch 3 & 4.

Channel 5-6 Show audio phase between Ch 5 & 6.

Channel 7-8 Show audio phase between Ch 7 & 8.

Channel 1-8 Show four phase diagrams Ch 1 & 2, thru Ch 7 & 8.

Channel 9-16 Show four phase diagrams Ch 9 & 10, thru Ch 15 & 16.

Level Meter Display Level Meter

Infinite Peak Hold Turns on Infinite Peak Hold

Reset Peak Resets audio peak level to the current audio level.

Timecode on 
Image

Enable (on/off) Show Timecode box on the image. CTRL+t

SafeArea on 
Image

Enable (on/off) Show framing guides on the image. CTRL+s

System Shutdown Closes the application and powers off the system.
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Menu Menu Option 1 Menu 
Option 2 Description Keyboard 

Shortcut 

System Restart Restarts the system and automatically relaunches the 
application.

Application Restart Restarts the application without shutting down the 
system.

Setup Menu Guide
Table 10.  Analyzer Mode > Audio, Timecode, SafeArea

Menu Menu Option 1 Description Keyboard 
Shortcut 

Manage LUTs Load New LUT Opens the Windows Explorer browser used to navigate to and 
load a 3d Mesh or a .cube LUT file. 

Delete LUT Opens a list of the currently loaded LUTs that you can select for 
deletion.

Delete All LUTs Deletes all currently loaded LUTs.

Create Setup Opens a dialog box for naming and saving a new Setup file. This 
file will have the current operational settings.

Open Setup (selection list) Opens the selected Setup file.

Delete <name> Deletes the currently open Setup file.

Reset <name> Resets the currently open Setup file to the settings it had when 
saved.



HDR Image Analyzer 12G ﻿ v3.0	 57	 www.aja.com

﻿

Video Menu Guide
Table 11.  Video Menu Options 

Menu Menu Option 1 Menu Option 2 Description Keyboard 
Shortcut 

Select 
from:

SDI1

SDI2

SDI3

SDI4

All SDI 
Inputs

Only SDI1 
is available 
for Quad-
Link SDI 
Input.

Resolution 720P Defines input video signal selected input 
Channel(s). 

HD

2K

UHD

4K

UHD2

Colorspace YCbCr 10Bit Defines the input video colorspace.

RGB 10 Bit

RGB 12 Bit

RGB Range is Legal

Transport Single-link Defines input video transport type.

Dual-link

Quad-link

4K Pixel Mapping SQD Square Division mapping

2SI Two Sample Interleave mapping

Auto Detect Toggles Auto Detect of the incoming SDI 
link On or Off.

Input 
Setup

Quad-Link SDI Input Configure for single input Channel analysis.

Four SDI Inputs Configure for four input Channel analysis

Screenshot Save Screenshot Captures a screenshot of the Analyzer UI to 
the host computer. 

CTRL+e

Copy 
Screenshots

(Opens a file 
browser for 
selection of a 
folder to copy to.) 

Copy All Copies all captured screenshots into the 
selected folder.

Copy Today's Copies only screenshots captured today 
into the selected folder.

Copy All Except 
Today's

Copies all screenshots except those 
captured today into the selected folder

Delete 
Screenshots

Delete All Deletes all captured screenshots from the 
host computer.

Delete Today's Deletes only screenshots captured today 
from the host computer.

Delete All Except 
Today's

Deletes all screenshots except those 
captured today from the host computer.
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Channels Menu Guide
Table 12.  Channels Menu Options

Menu Menu Option 1 Menu Option 2 Description Keyboard 
Shortcut 

Select 
from:

Channel 1

Channel 2

Channel 3

Channel 4

Input Select from:

SDI 1, SDI 2, SDI 3, or 
SDI 4

Only SDI 1 is available 
for Quad-Link SDI

Selects that SDI video as input. 2

NDI Inputs Displays a list of NDI sources available on the 
network for selection as video input.

Capture Capture 1 Capture Channel 1 and show immediately. ALT+ NumPad 1

Capture 2 Capture Channel 2 and show immediately. ALT+ NumPad 2

Capture 3 Capture Channel 3 and show immediately. ALT+ NumPad 3

Capture 4 Capture Channel 4 and show immediately. ALT+ NumPad 4

Recall Show Live Show live input signal for selected Channel.

Show live input signal for Channel 1. SHIFT+ NumPad 1

Show live input signal for Channel 2. SHIFT+ NumPad 2

Show live input signal for Channel 3. SHIFT+ NumPad 3

Show live input signal for Channel 4. SHIFT+ NumPad 4

Show Captured 1 Show captured image for Channel 1. CTRL+ NumPad 1

Show Captured 2 Show captured image for Channel 2. CTRL+ NumPad 2

Show Captured 3 Show captured image for Channel 3. CTRL+ NumPad 3 

Show Captured 4 Show captured image for Channel 4. CTRL+ NumPad 4
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Log Menu Guide
Table 13.  Log Menu Options

Menu Menu Option 1 Description Keyboard 
Shortcut 

Start/Stop Logging To A File Selecting "Start" creates a new file for a QC session log. The 
parameter name then changes to "Stop", and pressing it then 
stops logging to that file.

CTRL+l

Reset Log Data Clears current log data. CTRL+d

Copy Logs

(Opens a file 
browser for 
selection of a 
folder to copy to.)

Copy All Log Files Copies all log files into the selected folder.

Copy Today's Log Files Copies only log files captured today into the selected folder.

Copy All Except Today's 
Log Files

Copies all log files except those captured today into the selected 
folder

Delete Logs Delete All Log Files Deletes all log files from the host computer.

Delete Today's Log Files Deletes only log files captured today from the host computer.

Delete All Except 
Today's Log Files

Deletes all log files except those captured today from the host 
computer.

Log Window 
Timecode

Timestamp Comments in the Log Window to be tagged based on session 
clock.

Timecode Comments in the Log Window to be tagged based on SDI 
timecode.

Auto Timecode/
Timestamp

Shows timecode, timestamp, or both in the Log Window if the 
information is present on the incoming signal.

Timestamp - Timecode Show both time stamps with session clock priority.

Timecode - Timestamp Show both time stamps with SDI timecode priority.

Set Time Opens a window that allows you to change the time used by the 
local computer, which will be entered into logs.

Show Maximum Values Toggles maximum value display on the Gamut tool on and off. CTRL+m

Help Menu Guide
Table 14.  Help Menu Options

Menu Description Keyboard 
Shortcut 

About Displays the Application name and Version information. ALT+Forward Slash (/)

Update Analyzer Opens a browser allowing HDR Image Analyzer 12G software update.

License Utility Open a pane allowing HDR Image Analyzer 12G license update.
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Appendix A – Specifications

HDR Image Analyzer 12G Tech Specs 
Log/SDR/HDR Image Analysis Tool

Multi-Channel HDR Waveform, Histogram and Vectorscope Monitoring

Video Formats
•	 (8K) 8192x4320p 23.98, 24, 25, 29.97, 30, 47.95, 48, 50, 59.94, 60
•	 (UltraHD2) 7680x4320p 23.98, 24, 25, 29.97, 30, 50, 59.94, 60
•	 (4K) 4096x2160p 23.98, 24, 25, 29.97, 30, 47.95, 48, 50, 59.94, 60
•	 (UltraHD) 3840x2160p 23.98, 24, 25, 29.97, 30, 50, 59.94, 60
•	 (2K) 2048x1080p 23.98, 24, 25, 29.97, 30, 47.95, 48, 50, 59.94, 60
•	 (2K) 2048x1080PsF 23.98, 24, 25, 29.97, 30
•	 (HD) 1080p 23.98, 24, 25, 29.97, 30, 50, 59.94, 60
•	 (HD) 1080PsF 23.98, 24, 25, 29.97, 30
•	 (HD) 720p 50, 59.94, 60

Video Codec
•	 NDI SpeedHQ (High Bandwidth)

Audio Streams/Codec
•	 NDI (uncompressed float)
•	 SDI (PCM)

SDI Video Input Digital
•	 4x 12G-SDI BNC
•	 12G-SDI, SMPTE-259/292/296/424/425/2081/2082/2036, 12-bit, 10-bit, and 8-bit

NDI Video Input
•	 2x 10 GigE RJ-45
•	 4x NDI (approx. 105-250Mbit/s per channel)

•	 UYVY, 4:2:2, 10-bit and 8-bit
•	 UYVA, 4:2:2, 10-bit and 8-bit

Note: Interlaced formats are not supported. 

Video Inputs
•	 SDI connections are input only

•	 8K/UltraHD2 with 12G-SDI, all four connections are used
•	 4K/UltraHD with 12G-SDI, all four connections can be used
•	 4K/UltraHD with 3G-SDI, all four connections are used
•	 2K/HD with 3G-SDI, all four connections can be used

Note: When connections are configured for 12G-SDI or 6G-SDI, only 8K/
UltraHD2/4K/UltraHD formats are supported.

•	 NDI connections are input only
•	 4K/UltraHD/2K/HD

Audio Input/Output Digital
•	 16-channel 24-bit SDI embedded, 48 kHz synchronous
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NDI Audio Input
•	 16-channel, uncompressed float, 48 kHz sample rate, per NDI connection

Computer Monitor Output
•	 4x Display Port Outputs:

•	 Up to UltraHD 60p 
•	 Supports HDR10/PQ output

Network Interface
•	 2x RJ-45, 10 GigE
•	 Embedded web server for remote control
•	 Remote Desktop Protocol (RDP) 

Size: (w x d x h)
•	 1RU form factor
•	 17.2” x 16.9" x 1.7" (436.88 x 429.26 x 43.18 mm) 

Weight
•	 28 lb (12.7kg) in box
•	 18 lb (8.2kg) server only

Power
•	 100-240 VAC 50/60 Hz (Dual, redundant power supplies) 
•	 190W typical, 245W Maximum

Environment
•	 Safe Operating Temperature: 5 to 35 C (41 to 95 F) 
•	 Safe Storage Temperature (Power OFF): -40 to 60 C (-40 to 140 F) 
•	 Operating Relative Humidity: 8-90% noncondensing 
•	 Nonoperating Relative Humidity: 5-95% noncondensing
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Appendix B – Safety and Compliance
Federal Communications Commission (FCC) Compliance Notices

Class A Interference Statement

This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15, Subpart B of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected.
•	 Consult the dealer or an experienced radio/TV technician for help.

FCC Caution

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation.

Canadian ICES Statement
Canadian Department of Communications Radio Interference Regulations

This digital apparatus does not exceed the Class A limits for radio-noise emissions 
from a digital apparatus as set out in the Radio Interference Regulations of 
the Canadian Department of Communications. This Class A digital apparatus 
complies with Canadian ICES-003.

Règlement sur le brouillage radioélectrique du ministère des Communications

Cet appareil numérique respecte les limites de bruits radioélectriques visant les 
appareils numériques de classe A prescrites dans le Règlement sur le brouillage 
radioélectrique du ministère des Communications du Canada. Cet appareil 
numérique de la Classe A est conforme à la norme NMB-003 du Canada.

European Union, European Free Trade Association (EFTA) and 
United Kingdom Regulatory Compliance

This equipment may be operated in the countries that comprise the member 
countries of the European Union, European Free Trade Association and the United 
Kingdom. These countries, listed in the following paragraph, are referred to as 
The European Community throughout this document:

AUSTRIA, BELGIUM, BULGARIA, CROATIA, CZECH REPUBLIC, DENMARK, ESTONIA, 
FINLAND, FRANCE, GERMANY, GREECE, HUNGARY, ICELAND, IRELAND, ITALY, 
LATVIA, LIECHTENSTEIN, LITHUANIA, LUXEMBOURG, MALTA, NETHERLANDS, 
NORWAY, POLAND, PORTUGAL, REPUBLIC OF CYPRUS, ROMANIA, SLOVAK 
REPUBLIC, SLOVENIA, SPAIN, SWEDEN, SWITZERLAND, UNITED KINGDOM
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Declaration of Conformity

Marking by these symbols indicates compliance with the Essential Requirements 
of the EMC Directive of the European Union 2014/30/EU.

This equipment meets the following conformance standards:

Safety

EN 62368-1: 2014 + A11 (T-Mark License),

IEC 62368-1: 2014; (CB Scheme Certificate).

Emissions

EN 55032: 2015 + A11: 2020, CISPR 32: 2015,

EN 61000-3-2: 2014, EN 61000-3-3: 2013

Immunity

EN 55035: 2017 + A11: 2020, EN 61000-4-2: 2009, EN 61000-4-3: 2006+ A1: 2008 +

A2: 2010, EN 61000-4-4: 2012, EN 61000-4-5: 2014/A1: 2017, EN 61000-4-6: 2014,

EN 61000-4-8: 2010, EN 61000-4-11: 2020

Environments: E2, E3 and E4

The product is also licensed for additional country specific standards as required 
for the International Marketplace.

Warning! This is a Class A product. In a domestic environment, this product 
may cause radio interference, in which case, the user may be required to take 
appropriate measures.

Achtung! Dieses ist ein Gerät der Funkstörgrenzwertklasse A. In Wohnbereichen 
können bei Betrieb dieses Gerätes Rundfunkstörungen auftreten, in welchen 
Fällen der Benutzer für entsprechende Gegenmaßnahmen verantwortlich ist.

Attention! Ceci est un produit de Classe B. Dans un environnement domestique, ce 
produit risque de créer des interférences radioélectriques, il appartiendra alors à 
l'utilisateur de prendre les mesures spécifiques appropriées.

Recycling Notice

This symbol on the product or its packaging indicates that this product 
must not be disposed of with your other household waste. Instead, it is your 
responsibility to dispose of your waste equipment by handing it over to a 
designated collection point for the recycling of waste electrical and electronic 
equipment. The separate collection and recycling of your waste equipment 
at the time of disposal will help conserve natural resources and ensure that 
it is recycled in a manner that protects human health and the environment. 
For more information about where you can drop off your waste for recycling, 
please contact your local authority, or where you purchased your product.
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Korea KCC Compliance Statement

      

         

      . 

 

Taiwan Compliance Statement

This is a Class A product based on the standard of the Bureau of Standards, 
Metrology and Inspection (BSMI) CNS 13438, Class A. In a domestic environment 
this product may cause radio interference in which case the user may be required 
to take adequate measures.

Japan Compliance Statement

This is a Class A product based on the standard of the VCCI Council (VCCI 32: 2016). 
If this equipment is used in a domestic environment, radio interference may 
occur, in which case, the user may be required to take corrective actions.

China Compliance Statement 
This product has been tested to the following Chinese standards:

GB/T 9254.1-2021; GB 4943.1-2022; GB 17625.1-2022 

This is to certify that the above mentioned product(s) complies with the 
requirements of certification rules of CQC12-045800-2022 under certificate 
number CQC22001369272.

Translated Warning and Caution Messages
The following caution statements, warning conventions, and warning messages 
apply to this product and manual.
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Before Operation Please Read These Instructions

Warning! Read and follow all warning notices and instructions marked on the 
product or included in the documentation.

Avertissement! Lisez et conformez-vous à tous les avis et instructions 
d'avertissement indiqués sur le produit ou dans la documentation.

Warnung! Lesen und befolgen Sie die Warnhinweise und Anweisungen, die auf 
dem Produkt angebracht oder in der Dokumentation enthalten sind.

¡Advertencia! Lea y siga todas las instrucciones y advertencias marcadas en el 
producto o incluidas en la documentación.

Aviso! Leia e siga todos os avisos e instruções assinalados no produto ou incluídos 
na documentação.

Avviso! Leggere e seguire tutti gli avvisi e le istruzioni presenti sul prodotto o 
inclusi nella documentazione. 

Warning! Do not use this device near water and clean only with a dry cloth.
Avertissement! N'utilisez pas cet appareil près de l'eau et nettoyez-le seulement 

avec un tissu sec.
Warnung! Das Gerät nicht in der Nähe von Wasser verwenden und nur mit einem 

trockenen Tuch säubern.
¡Advertencia! No utilice este dispositivo cerca del agua y límpielo solamente con 

un paño seco.
Aviso! Não utilize este dispositivo perto da água e limpe-o somente com um pano 

seco.
Avviso! Non utilizzare questo dispositivo vicino all'acqua e pulirlo soltanto con un 

panno asciutto. 

Warning! Do not block any ventilation openings. Install in accordance with the 
manufacturer's instructions.

Avertissement! Ne bloquez aucune ouverture de ventilation. Suivez les 
instructions du fabricant lors de l'installation.

Warnung! Die Lüftungsöffnungen dürfen nicht blockiert werden. Nur gemäß den 
Anweisungen des Herstellers installieren.

¡Advertencia! No bloquee ninguna de las aberturas de la ventilación. Instale de 
acuerdo con las instrucciones del fabricante.

Aviso! Não obstrua nenhuma das aberturas de ventilação. Instale de acordo com as 
instruções do fabricante.

Avviso! Non ostruire le aperture di ventilazione. Installare in conformità con le 
istruzioni del fornitore. 

Warning! Do not install near any heat sources such as radiators, heat registers, 
stoves, or other apparatus (including amplifiers) that produce heat.

Avertissement! N'installez pas l'appareil près d'une source de chaleur telle que des 
radiateurs, des bouches d'air de chauffage, des fourneaux ou d'autres appareils 
(amplificateurs compris) qui produisent de la chaleur.

Warnung! Nicht in der Nähe von Wärmequellen wie Heizkörpern, Heizregistern, 
Öfen oder anderen Wärme erzeugenden Geräten (einschließlich Verstärkern) 
aufstellen.

¡Advertencia! No instale cerca de fuentes de calor tales como radiadores, registros 
de calor, estufas u otros aparatos (incluidos amplificadores) que generan calor.

Aviso! Não instale perto de nenhuma fonte de calor tal como radiadores, saídas 
de calor, fogões ou outros aparelhos (incluindo amplificadores) que produzam 
calor.

Avviso! Non installare vicino a fonti di calore come termosifoni, diffusori di aria 
calda, stufe o altri apparecchi (amplificatori compresi) che emettono calore.
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Warning! Do not defeat the safety purpose of the polarized or grounding-
type plug. A polarized plug has two blades with one wider than the other. A 
grounding type plug has two blades and a third grounding prong. The wide 
blade or the third prong are provided for your safety. If the provided plug does 
not fit into your outlet, consult an electrician for replacement of the obsolete 
outlet.

Avertissement! La sécurité de la prise polarisée ou de la prise de type mise à la 
terre ne doit en aucun cas être empêchée de fonctionner. Une prise polarisée 
a deux broches, l'une étant plus large que l'autre. Une prise de type mise à la 
terre a deux broches et une troisième broche pour la mise à la terre. La broche 
large ou la troisième broche sont fournies pour votre sécurité. Si la prise 
fournie ne s'insère pas dans votre prise femelle, consultez un électricien pour le 
remplacement de la prise femelle obsolète.

Warnung!  Der Sicherheitszweck des gepolten bzw. Schukosteckers ist zu 
berücksichtigen. Ein gepolter Stecker verfügt über zwei Pole, von denen einer 
breiter als der andere ist. Ein Schukostecker verfügt neben den zwei Polen noch 
über einen dritten Pol zur Erdung. Der breite Pol bzw. der Erdungspol dienen der 
Sicherheit. Wenn der zur Verfügung gestellte Stecker nicht in Ihren Anschluss 
passt, konsultieren Sie einen Elektriker, um den veralteten Anschluss zu ersetzen.

¡Advertencia! No eche por tierra la finalidad del tipo de enchufe polarizado con 
conexión a tierra. Un enchufe polarizado tiene dos espigas, una más ancha 
que la otra. Un enchufe con conexión a tierra tiene dos espigas iguales y una 
tercera espiga que sirve para la conexión a tierra. La expiga ancha, o la tercera 
espiga, sirven para su seguridad. Si el enchufe suministrado no encaja en el 
tomacorriente, consulte con un electricista para reemplazar el tomacorriente 
obsoleto.

Aviso! Não anule a finalidade da segurança da ficha polarizada ou do tipo ligação 
terra. Uma ficha polarizada tem duas lâminas sendo uma mais larga do que 
a outra. Uma ficha do tipo de ligação à terra tem duas lâminas e um terceiro 
terminal de ligação à terra. A lâmina larga ou o terceiro terminal são fornecidos 
para sua segurança. Se a ficha fornecida não couber na sua tomada, consulte um 
electricista para a substituição da tomada obsoleta.

Avviso! Non compromettere la sicurezza della spina polarizzata o con messa a 
terra. Una spina polarizzata ha due spinotti, di cui uno più largo. Una spina con 
messa a terra ha due spinotti e un terzo polo per la messa a terra. Lo spinotto 
largo o il terzo polo sono forniti per motivi di sicurezza. Se la spina fornita non 
si inserisce nella presa di corrente, contattare un elettricista per la sostituzione 
della presa obsoleta.

Warning! Since the Mains plug is used as the disconnection for the device, it must 
remain readily accessible and operable.

Avertissement! Puisque la prise principale est utilisée pour débrancher l'appareil, 
elle doit rester aisément accessible et fonctionnelle.

Warnung! Da der Netzstecker als Trennvorrichtung dient, muss er stets zugänglich 
und funktionsfähig sein.

¡Advertencia! Puesto que el enchufe de la red eléctrica se utiliza como dispositivo 
de desconexión, debe seguir siendo fácilmente accesible y operable.

Aviso! Dado que a ficha principal é utilizada como a desconexão para o dispositivo, 
esta deve manter-se prontamente acessível e funcional.

Avviso! Poiché il cavo di alimentazione viene usato come dispositivo di 
sconnessione, deve rimane prontamente accessibile e operabile.
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Warning! Protect the power cord from being walked on or pinched particularly at 
plugs, convenience receptacles, and the point where they exit from the device.

Avertissement! Protégez le cordon d'alimentation pour que l'on ne marche 
pas dessus ou qu'on le pince, en particulier au niveau des prises mâles, des 
réceptacles de convenance, et à l'endroit où il sort de l'appareil.

Warnung! Vermeiden Sie, dass auf das Netzkabel getreten oder das Kabel geknickt 
wird, insbesondere an den Steckern, den Steckdosen und am Kabelausgang am 
Gerät.

¡Advertencia! Proteja el cable de corriente para que no se le pise ni apriete, en 
especial cerca del enchufe, los receptáculos de conveniencia y el punto del que 
salen del equipo.

Aviso! Proteja o cabo de alimentação de ser pisado ou de ser comprimido 
particularmente nas fichas, em tomadas de parede de conveniência e no ponto 
de onde sai do dispositivo.

Avviso! Proteggere il cavo di alimentazione in modo che nessuno ci cammini sopra 
e che non venga schiacciato soprattutto in corrispondenza delle spine e del 
punto in cui esce dal dispositivo. 

Warning! Unplug this device during lightning storms or when unused for long 
periods of time.

Avertissement! Débranchez cet appareil pendant les orages avec éclairsou s'il est 
inutilisé pendant de longues périodes.

Warnung! Das Gerät ist bei Gewitterstürmen oder wenn es über lange Zeiträume 
ungenutzt bleibt vom Netz zu trennen.

¡Advertencia! Desenchufe este dispositivo durante tormentas eléctricas o cuando 
no se lo utilice por largos periodos del tiempo.

Aviso! Desconecte este dispositivo da tomada durante trovoadas ou quando não é 
utilizado durante longos períodos de tempo.

Avviso! Utilizzare soltanto i collegamenti e gli accessori specificati e/o venduti dal 
produttore, quali il treppiedi e l'esoscheletro. 
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Warning! Refer all servicing to qualified service personnel. Servicing is required 
when the device has been damaged in any way, such as power-supply cord or 
plug is damaged, liquid has been spilled or objects have fallen into the device, 
the device has been exposed to rain or moisture, does not operate normally, or 
has been dropped.

Avertissement! Référez-vous au personnel de service qualifié pour tout entretien. 
L'entretien est exigé quand l'appareil a été endommagé de quelque manière 
que ce soit, par exemple lorsque le cordon d'alimentation ou la prise sont 
endommagés, que du liquide a été versé ou des objets sont tombés dans 
l'appareil, que l'appareil a été exposé à la pluie ou à l'humidité, ne fonctionne pas 
normalement ou est tombé.

Warnung! Das Gerät sollte nur von qualifizierten Fachkräften gewartet werden. 
Eine Wartung ist fällig, wenn das Gerät in irgendeiner Weise beschädigt wurde, 
wie bei beschädigtem Netzkabel oder Netzstecker, falls Flüssigkeiten oder 
Objekte in das Gerät gelangen, das Gerät Regen oder Feuchtigkeit ausgesetzt 
wurde, nicht ordnungsgemäß funktioniert oder fallen gelassen wurde.

¡Advertencia! Consulte al personal calificado por cuestiones de reparación. El 
servicio de reparación se requiere cuando el dispositivo ha recibido cualquier 
tipo de daño, por ejemplo cable o espigas dañadas, se ha derramado líquido o 
se han caído objetos dentro del dispositivo, el dispositivo ha sido expuesto a la 
lluvia o humedad, o no funciona de modo normal, o se ha caído.

Aviso! Remeta todos os serviços de manutenção para o pessoal de assistência 
qualificado. A prestação de serviços de manutenção é exigida quando o 
dispositivo foi danificado mediante qualquer forma, como um cabo de 
alimentação ou ficha que se encontra danificado/a, quando foi derramado 
líquido ou caíram objectos sobre o dispositivo, quando o dispositivo foi exposto 
à chuva ou à humidade, quando não funciona normalmente ou quando foi 
deixado cair.

Avviso! Fare riferimento al personale qualificato per tutti gli interventi di assistenza. 
L'assistenza è necessaria quando il dispositivo è stato danneggiato in qualche 
modo, ad esempio se il cavo di alimentazione o la spina sono danneggiati, è 
stato rovesciato del liquido è stato rovesciato o qualche oggetto è caduto nel 
dispositivo, il dispositivo è stato esposto a pioggia o umidità, non funziona 
correttamente o è caduto.

Warning! Do not open the chassis. There are no user-serviceable parts inside. 
Opening the chassis will void the warranty unless performed by an AJA service 
center or licensed facility.

Avertissement! Ne pas ouvrir le châssis. Aucun élément à l’intérieur du châssis 
ne peut être réparé par l’utilisateur. La garantie sera annulée si le châssis est 
ouvert par toute autre personne qu’un technicien d’un centre de service ou d’un 
établissement agréé AJA.

Warnung! Öffnen Sie das Gehäuse nicht. Keine der Geräteteile können vom 
Benutzer gewartet werden. Durch das Öffnen des Gehäuses wird die Garantie 
hinfällig, es sei denn, solche Wartungsarbeiten werden in einem AJA-Service-
Center oder einem lizenzierten Betrieb vorgenommen.

¡Advertencia! No abra el chasis. El interior no contiene piezas reparables por el 
usuario. El abrir el chasis anulará la garantía a menos que se lo haga en un centro 
de servicio AJA o en un local autorizado.

Advertência! Não abra o chassi. Não há internamente nenhuma peça que permita 
manutenção pelo usuário. Abrir o chassi anula a garantia, a menos que a abertura 
seja realizada por uma central de serviços da AJA ou por um local autorizado.

Avvertenza! Non aprire lo chassis. All’interno non ci sono parti riparabili 
dall’utente. L’apertura dello chassis invaliderà la garanzia se non viene effettuata 
da un centro ufficiale o autorizzato AJA. 
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Warning! Disconnect the external AC power supply line cord(s) from the mains 
power before moving the unit.

Avertissement! Retirez le ou les cordons d’alimentation en CA de la source 
d’alimentation principale lorsque vous déplacez l’appareil. 

Warnung! Trennen Sie die Wechselstrom-Versorgungskabel vom Netzstrom, bevor 
Sie das Gerät verschieben.

¡Advertencia! Cuando mueva la unidad desenchufe de la red eléctrica el/los 
cable(s) de la fuente de alimentación CA tipo brick.

Advertência! Remova os cabos CA de alimentação brick da rede elétrica ao mover 
a unidade.

Avvertenza! Scollegare il cavo dell’alimentatore quando si sposta l’unità.

Warning! Only use attachments and accessories specified and/or sold by the 
manufacturer.

Avertissement! Utilisez seulement les attaches et accessoires spécifiés et/ou 
vendus par le fabricant.

Warnung! Verwenden Sie nur Zusatzgeräte und Zubehör angegeben und / oder 
verkauft wurde durch den Hersteller.

¡Advertencia! Utilice solamente los accesorios y conexiones especificados y/o 
vendidos por el fabricante.

Aviso! Utilize apenas equipamentos/acessórios especificados e/ou vendidos pelo 
fabricante.

Avviso! Utilizzare soltanto i collegamenti e gli accessori specificati e/o venduti dal 
produttore. 

Hazard! High Voltage. This situation or condition can cause injury due to electric 
shock.

Avertissement! Tension élevée. Cette situation ou condition peut causer des 
blessures dues à un choc électrique.

Warnung!  Hochspannung. Diese Situation oder Bedingung kann zu Verletzungen 
durch Stromschlag führen. 

¡Advertencia!  Alto voltaje . Esta situación o condición puede causar lesiones 
debidas a una descarga eléctrica.

Aviso!  Alta Tensão . Esta situação ou condição pode causar danos devido a 
choques elétricos.

Avviso!  Alta tensione. Questa situazione o condizione può causare lesioni a causa 
di scosse elettriche.

Warning! Dual Power Cord Notice—please read this. To reduce the risk of electrical 
shock,disconnect both power cords before servicing equipment.

Avertissement! Avis concernant la double alimentation électrique — à lire 
soigneusement. Pour éviter tout risque d’électrocution, débranchez les deux 
câbles électriques avant d’intervenir sur l’équipement.

Achtung! Hinweis auf Doppel-Netzkabel—bitte lesen. Um das Risiko eines 
Elektroschocks zu verringern, müssen beide Netzkabel ausgestöpselt werden, 
bevor die Vorrichtung gewartet wird.

Avvertenza. Avviso concernente il cavo di alimentazione doppio – leggere 
attentamente. Per ridurre il rischio di elettrocuzione, scollegare entrambi i cavi 
di alimentazione prima di eseguire la manutenzione o riparazioni di questo 
apparecchio.

Aviso! Aviso de Cabo Elétrico Duplo - por favor, leia isto. Para reduzir o risco 
de choque elétrico, desconecte ambos os cabos elétricos antes de fazer 
manutenção ao equipamento.

¡Advertencia! Aviso del doble cable de alimentación - leer esto por favor. 
Para reducir el riesgo de descarga eléctrica, desconecte ambos cables de 
alimentación antes de dar servicio al equipo.
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Caution! To meet safety regulations for leakage current, connect the dual power 
supplies to separate branch circuits.

¡Advertencia! Para cumplir con las normas de seguridad para la corriente de fuga, 
conecte las dos fuentes de alimentación para circuitos derivados diferentes.

Attention! Pour répondre aux mesures de sécurité concernant le courant de 
fuite, raccorder les sources d'alimentation doubles à des circuits de dérivation 
distincts.

Warnung! Zur Erfüllung der Sicherheitsbestimmungen bezüglich Reststrom 
schließen Sie bitte die zwei Netzteile an unterschiedlichen Abzweigleitungen an.

Cuidado! Para atender aos regulamentos de segurança para correntes de fuga, 
conecte as fontes duplas a circuitos elétricos separados.

Attenzione! Per soddisfare le norme di sicurezza sulla corrente di perdita, 
collegare i doppi alimentatori a circuiti derivati separati.

Warning! Hazardous Voltages! The safe operation of this product requires that a 
protective earth connection be provided. This protective earth is provided by 
the grounding conductor in the equipment's supply cord. To reduce the risk of 
electrical shock to operator and service personnel, this ground conductor must 
be connected to an earthed ground.

Avertissement : tensions dangereuses — Pour utiliser ce produit en toute sécurité, 
il faut un raccordement à la terre. Ce raccordement s’effectue par l’intermédiaire 
du connecteur de terre dans le cordon d’alimentation de l’équipement. Pour 
réduire le risque d’électrocution de l’opérateur ou du personnel de maintenance, 
ce cordon avec conducteur de terre doit être branché sur une prise reliée à la 
terre.

Achtung! Gefährliche Spannungen — Sichere Bedienung dieses Geräts erfordert, 
dass ein Schutzleiteranschluss vorgesehen wird. Dieser Schutzleiteranschluss 
wird mittels der Erdungsleitung im Netzkabel der Vorrichtung vorgesehen. 
Um die Gefahr eines Elektroschocks für Bedien- und Wartungspersonal zu 
verringern, muss diese Erdungsleitung mit einer geerdeten Masse verbunden 
werden.

Avvertenza – Alte tensioni – Il funzionamento in sicurezza di questo prodotto 
richiede una presa di terra, che viene fornita dal conduttore di messa a terra 
presente nel cavo di alimentazione dell’apparecchio. Per ridurre il rischio di 
elettrocuzione per l’operatore e il personale di manutenzione, tale conduttore 
deve essere collegato a un punto al potenziale di terra.

Advertencia de voltajes peligrosos — El funcionamiento seguro de este producto 
require que se proporcione una conexión terrestre protegida. Esta protección 
terrestre es proporcionada por el conductor de conexión en la tierra del cable de 
alimentación del equipo. Para reducir el riesgo de descarga eléctrica al operador 
y el personal de servicio, este conductor de conexión de la tierra debe ser 
conectado a la misma tierra.
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3 Year Warranty and Liability Information
Limited Warranty on Hardware

AJA Video Systems, Inc. (AJA Video) warrants that the hardware product, not 
including storage modules or software components, will be free from defects in 
materials and workmanship for a period of three years from the date of purchase. AJA 
Video warrants that the storage modules provided as part of the hardware product 
will be free from defects in materials and workmanship for a period of one year from 
the date of purchase. AJA Video provides a separate software warranty as part of the 
license agreement applicable to software components.

If the Customer brings a valid claim under this limited warranty for a hardware 
product or storage module (hereafter, a “product”) during the applicable warranty 
period, AJA Video will, at its sole option and as the Customer’s sole remedy for breach 
of the above warranty, provide one of the following remedies: 

•	 Repair or facilitate the repair the product within a reasonable period of time, free 
of charge for parts and labor. 

•	 Replace the product with a direct replacement or with a product that performs 
substantially the same function as the original product. 

•	 Issue a refund of the original purchase price less depreciation to be determined 
based on the age of the product at the time remedy is sought under this limited 
warranty.

To obtain service under this warranty, the Customer must notify AJA Video of the 
defect before expiration of the warranty period and make suitable arrangements for 
the performance of service by contacting AJA Video support through the channels 
set forth on the support contacts web page at https://www.aja.com/support. 
Except as stated, the Customer shall bear all shipping, packing, insurance and other 
costs, excluding parts and labor, to effectuate repair. Customer shall pack and ship 
the defective product to a service center designated by AJA Video, with shipping 
charges prepaid. AJA Video shall pay to return the product to Customer, but only 
if to a location within the country in which the AJA Video service center is located. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR 
LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO SOME OR ALL 
OF THE TERMS OF THIS PARAGRAPH MAY NOT APPLY TO YOU.

Limitation of Liability
Under no circumstances shall AJA video BE LIABLE IN ANY WAY FOR ANY LOST, 
CORRUPTED OR DESTROYED DATA, FOOTAGE OR WORK, OR FOR ANY OTHER 
INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOST PROFITS, 
OR FOR ANY THIRD PARTY CLAIM, IN CONNECTION WITH THE PRODUCT, WHETHER 
RESULTING FROM DEFECTS IN THE PRODUCT, SOFTWARE OR HARDWARE FAILURE, 
OR ANY OTHER CAUSE WHATSOEVER, EVEN IF AJA VIDEO HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. AJA VIDEO’S LIABILITY IN CONNECTION WITH THE 
PRODUCT SHALL UNDER NO CIRCUMSTANCES EXCEED THE PURCHASE PRICE PAID 
FOR THE PRODUCT. The foregoing limitations apply even if any remedy set forth in 
this LIMITED WARRANTY fails of its essential purpose. SOME JURISDICTIONS DO NOT 
ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO SOME OR ALL OF THE TERMS OF THIS PARAGRAPH 
MAY NOT APPLY TO YOU.  

Governing Law and Language; Your Rights
This limited warranty is the only warranty provided by AJA Video on the hardware 
product. It supersedes all prior or contemporaneous understandings regarding such 
subject matter. No amendment to or modification of this warranty will be binding 
unless in writing and signed by AJA Video. The laws of the State of California, USA 
will govern this warranty and any dispute arising from it. Any translation of this 
Agreement is intended for convenience and to meet local requirements and in the 
event of a dispute between the English and any non-English versions, the English 
version of this warranty will govern. This limited warranty gives you specific legal 
rights and you may have other rights that vary from jurisdiction to jurisdiction, some 
of which are noted above.
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AJA Software License Agreement
AJA VIDEO SYSTEMS, INC.

THIS IS AN AGREEMENT BETWEEN YOU AND AJA VIDEO SYSTEMS, INC. (“AJA”) THAT 
GOVERNS YOUR USE OF THE SOFTWARE ACCOMPANYING THIS LICENSE (E.G., AS 
INSTALLED ON THE DEVICE WITH WHICH THIS LICENSE IS PROVIDED). 

The “AJA Software” referenced in this Agreement includes all such software, whether 
made available to you on disk, in read only memory, on any other media or in any 
other form, and all updates, corrections, enhancements and new versions of such 
software made available by AJA, together with all related documentation.  BY 
INSTALLING OR USING THE AJA SOFTWARE, YOU ARE AGREEING TO BE BOUND BY 
THE TERMS OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, DO NOT INSTALL OR USE IT AND, IF APPLICABLE, RETURN THE AJA 
SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT FOR A REFUND.

1. 	License Grant.  AJA hereby grants you a nonexclusive, personal, non-sublicenseable 
and limited license to install and use AJA Software on a computer or AJA device. 
The foregoing license also includes the right to make copies of the AJA Software in 
machine-readable form for installation and backup purposes only, and provided that 
each copy you make must include all copyright or other proprietary notices contained 
on the original.  

2. 	Limitations. You may not decompile, reverse engineer, disassemble, modify, or 
create derivative works of the AJA Software or any part thereof except to the extent 
(if any) authorized by applicable law notwithstanding the foregoing restriction. You 
may not rent, lease, lend, loan, distribute or act as a service bureau or “cloud service” 
provider with respect to use of the AJA Software or any functionality thereof. THE AJA 
SOFTWARE IS NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR FACILITIES, 
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL 
SYSTEMS, LIFE SUPPORT MACHINES OR OTHER EQUIPMENT IN WHICH THE FAILURE OF 
THE AJA SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL 
OR ENVIRONMENTAL DAMAGE. 

3. 	Reservation of Rights.  The AJA Software is protected by law, including without 
limitation copyright law.  The AJA Software is licensed, not sold, to you.  AJA and its 
licensors reserve all rights not expressly granted to you by this Agreement.  You own 
the media on which the AJA Software is recorded but AJA and/or AJA's licensor(s) 
retain ownership of the AJA Software itself.  You may not use the AJA Software for any 
illegal purpose. 

4. 	Transfer. You may make a one-time permanent transfer of all of your license rights 
to the AJA Software to another person or entity, provided that: (a) you transfer 
all of the AJA Software, including all its component parts, original media, printed 
materials and this Agreement; (b) you do not retain any copies of the AJA Software, 
including any copies stored on a computer or other device; and (c) you transfer the 
AJA Software subject to this Agreement, and the person or entity receiving the AJA 
Software accepts the terms and conditions of this Agreement. 

5. 	NFR (Not for Resale) Copies and Add-On Features: Notwithstanding anything to 
the contrary in this Agreement, (a) AJA Software that is labeled “Not for Resale” or 
otherwise provided to you on a promotional or demonstration basis may be used only 
for your demonstration, testing and evaluation purposes and may not be resold or 
transferred; and (b) AJA may make available certain software components (“Add-On 
Features”) under separate terms and conditions, in which case those separate terms 
and conditions apply and the Add-On Features are not considered AJA Software 
under this Agreement.

6. 	Termination.  Your rights in the AJA Software are conditioned on complying with 
this Agreement, and those rights (together with this Agreement) will terminate 
automatically, without notice from AJA, if you fail to comply with any term(s) of this 
Agreement. Upon termination of this Agreement, you must cease all use of the AJA 
Software and destroy all copies, full or partial, of the AJA Software in your possession 
or control.

7. 	Limited Warranty on AJA Software.  If you comply with all terms of this Agreement 
and use the AJA Software in accordance with its documentation, and you install any 
patches or other updates made available to the AJA Software by AJA, AJA warrants 
that the AJA Software will perform substantially in accordance with its documentation 
for a period of ninety (90) days from the date of your original retail purchase.  Your 
exclusive remedy under this warranty will be, at AJA’s option, a refund of the purchase 
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price of the product containing the AJA Software or an update to or replacement of 
the AJA Software (or applicable component of it).  THIS LIMITED WARRANTY AND ANY 
IMPLIED WARRANTIES ON THE AJA SOFTWARE INCLUDING, BUT NOT LIMITED TO, 
ANY WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OR OF FITNESS 
FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM 
THE DATE OF ORIGINAL RETAIL PURCHASE.  SOME JURISDICTIONS DO NOT ALLOW 
LIMITATIONS ON HOW LONG A WARRANTY LASTS, SO THE ABOVE LIMITATION MAY 
NOT APPLY TO YOU.  THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, 
AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

8. 	Disclaimer of Other Warranties on AJA Software.  EXCEPT FOR THE LIMITED 
WARRANTY ON AJA SOFTWARE SET FORTH ABOVE, AJA AND AJA'S LICENSORS 
(COLLECTIVELY REFERRED TO AS "AJA" FOR THE PURPOSES OF SECTIONS 8 AND 9) 
HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE AJA 
SOFTWARE, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, 
OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, 
AND OF QUIET ENJOYMENT.  FURTHER, AJA DOES NOT MAKE ANY WARRANTY 
REGARDING NON-INFRINGEMENT OF THIRD PARTY RIGHTS.  SUBJECT ONLY TO THE 
LIMITED WARRANTY SET FORTH IN SECTION 7, YOU EXPRESSLY ACKNOWLEDGE 
AND AGREE THAT USE OF THE AJA SOFTWARE IS AT YOUR SOLE RISK. AJA DOES NOT 
WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE AJA SOFTWARE, 
THAT THE AJA SOFTWARE WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION 
OF THE AJA SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS 
IN THE AJA SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION 
OR ADVICE GIVEN BY AJA OR AN AJA AUTHORIZED REPRESENTATIVE WILL CREATE 
A WARRANTY.  SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES OR LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, 
SO SOME OR ALL OF THE TERMS OF THIS PARAGRAPH MAY NOT APPLY TO YOU.

9. 	Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT WILL 
AJA BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OR LOST PROFITS WHATSOEVER, INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER 
COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE 
OR INABILITY TO USE THE AJA SOFTWARE, HOWEVER CAUSED, REGARDLESS OF THE 
THEORY OF LIABILITY (E.G., WHETHER UNDER CONTRACT, TORT OR OTHERWISE) 
AND EVEN IF AJA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO 
EVENT WILL AJA'S TOTAL LIABILITY TO YOU FOR ALL DAMAGES (INCLUDING WITHOUT 
LIMITATION BREACH OF WARRANTY) EXCEED THE AMOUNT OF FIFTY DOLLARS 
($50.00).  THE FOREGOING LIMITATIONS WILL APPLY EVEN IF THE ANY REMEDY SET 
FORTH IN THIS AGREEMENT FAILS OF ITS ESSENTIAL PURPOSE.  SOME JURISDICTIONS 
DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SOME OR ALL OF THE TERMS OF THIS 
PARAGRAPH MAY NOT APPLY TO YOU.

10. 	Export Law Assurances.  You may not use or otherwise export or reexport the AJA 
Software except as authorized by United States law and the laws of the jurisdiction in 
which the AJA Software was obtained.  In particular, but without limitation, the AJA 
Software may not be exported or re-exported (a) into (or to a national or resident of) 
any U.S. embargoed countries, or (b) to anyone on the U.S. Treasury Department's 
list of Specially Designated Nationals or the U.S. Department of Commerce Denied 
Persons List or Entity List or any similar legal designation.  By using the AJA Software, 
you represent and warrant that you are not located in, under control of, or a national 
or resident of any such country or on any such list.

11. 	Government End Users. The AJA Software including its documentation 
is a "Commercial Item", as that term is defined at 48 C.F.R. § 2.101, consisting 
of "Commercial Computer Software" and "Commercial Computer Software 
Documentation", as such terms are used in 48 C.F.R. § 12.212 or 48 C.F.R. § 227.7202 (or 
their successors), as applicable.  Consistent with these provisions, the AJA Software 
is licensed to U.S. Government end users (a) only as a Commercial Item and (b) with 
only those rights as are granted to all other end users pursuant to this Agreement.  
Unpublished-rights reserved under the copyright laws of the United States.

12. 	Controlling Law and Severability. This Agreement will be governed by and 
construed in accordance with the laws of the State of California, as applied to 
agreements entered into and to be performed entirely within California between 
California residents. This Agreement will not be governed by the United Nations 
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Convention on Contracts for the International Sale of Goods, the application of which 
is expressly excluded. If for any reason a court of competent jurisdiction finds any 
provision, or portion thereof, to be unenforceable, the remainder of this Agreement 
will continue in full force and effect.

13. 	Complete Agreement; Governing Language.  This Agreement constitutes the 
entire agreement between the parties with respect to the use of the AJA Software 
licensed hereunder and supersedes all prior or contemporaneous understandings 
regarding such subject matter. No amendment to or modification of this Agreement 
will be binding unless in writing and signed by AJA. Any translation of this Agreement 
is intended for convenience and to meet local requirements and in the event of a 
dispute between the English and any non-English versions, the English version of this 
Agreement will govern.
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